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Information technology (IT) is the use of any computer, storage, networking and other
physical devices, infrastructure and processes to create, process, store, secure and exchange
all forms audio video text image of electronic data.

communication hardware
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DEFINITION: THE USE OF COMPUTER, HARDWARE AND
SOFTWARE TO STORE, RETRIEVE AND MANIPULATE
INFORMATION

SPEED

RELIABILITY

CONSISTENCY

COMMUNICATION

STORAGE

VIOLATION OF PRIVACY

PUBLIC SAFETY

IMPACT TO LABOUR FORCE

HEALTH RISK

IMPACT ON ENVIROMENT

CATEGORIES OF COMPUTERS

SIZE: OCCUPY A FULL ROOM OF EQUIPMENT
SPEED: TENS OF THOUSANDS OF PROCESSORS
STORAGE: EXTREMELY LARGE (3.1 PB)

SIZE: PARTIAL ROOM TO A FULL ROOM OF EQUIPMENT
SPEED: DOZENS OF PROCESSORS
STORAGE: VERY LARGE & ADDABLE STORAGE (4.6 TB

SIZE: FITS ON THE DESK

SPEED: SINGLE PROCESSOR (1.5-2.5Ghz)
STORAGE: LARGE (500GB)

SIZE: FIT ON YOUR LAP OR ON YOUR HAND
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Hardware

Hardware refers to the physical elements of a computer. This is also sometime called the
machinery or the equipment of the computer. Examples of hardware in a computer are the
keyboard, the monitor, the mouse and the central processing unit. However, most of a
computer's hardware cannot be seen; in other words, it is not an external element of the
computer, but rather an internal one, surrounded by the computer's casing (tower). A
computer's hardware is comprised of many different parts, but perhaps the most important
of these is the motherboard. The motherboard is made up of even more parts that power
and control the computer.

In contrast to software, hardware is a physical entity. Hardware and software are
interconnected, without software, the hardware of a computer would have no function.
However, without the creation of hardware to perform tasks directed by software via the
central processing unit, software would be useless.

Hardware Components

Computer hardware is a collection of several components working together. Some parts are
essential and others are added advantages. Computer hardware is made up of CPU and
peripherals as shown in image below.

Keyboard | Monitor
P
Mouse CPy | Printer
.~ Dato i nformation
I L S e
Other |/P devices [~ | | Speaker
HDD cD
Other |/P devices Memory Other O/P devices
BIOS
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Software

Software, commonly known as programs or apps, consists of all the instructions that tell the
hardware how to perform a task. These instructions come from a software developer in the
form that will be accepted by the platform (operating system + CPU) that they are based on.
For example, a program that is designed for the Windows operating system will only work for
that specific operating system.

A set of instructions that drives computer to do stipulated tasks is called a program. Software
instructions are programmed in a computer language, translated into machine language, and
executed by computer.

Software is capable of performing many tasks, as opposed to hardware which can only
perform mechanical tasks that they are designed for. Software provides the means for
accomplishing many different tasks with the same basic hardware

Software can be categorized into two types -

o System software
o Application software

System Software

System software operates directly on hardware devices of computer. It provides a platform
to run an application. It provides and supports user functionality. Examples of system
software include operating systems such as Windows, Linux, Unix, etc.
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Application Software

An application software is designed for benefit of users to perform one or more tasks.
Examples of application software include Microsoft Word, Excel, PowerPoint, Oracle, etc.

) Office
(3]

Excel OneNote Outlook Word PowerPoint
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Differences between Software and Hardware are sorted out below -

Sr.N Software

1 It is a collection of programs to
bring computer hardware
system into operation.

2 It includes numbers,
alphabets, alphanumeric
symbols, identifiers, keywords,
etc.

3 Software products evolve by
adding new features to
existing programs to support
hardware.

4 It will vary as per computer
and its built-in functions and
programming language.

5 It is designed and developed
by experienced programmers
in high-level language.

6 It is represented in any high-
level language such as BASIC,
COBOL, C, C++, JAVA, etc.

11| Page

Hardware

It includes physical components of
computer system.

It consists of electronic components
like ICs, diodes, registers, crystals,
boards, insulators, etc.

Hardware design is based on
architectural decisions to make it work
over a range of environmental
conditions and time.

It is mostly constructed for all types of
computer systems.

The hardware can understand only
low-level language or machine
language.

The hardware works only on binary
codes 1’s and
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Memory
100010104 (Location 0)

0’s.
7 The software is categorized as  The hardware consists of input
operating system, utilities, devices, output devices, memory, etc.

language processor,
application software, etc.

Functional Components of a Computer

Computer: A computer is a combination of hardware and software resources which
integrate together and provides various functionalities to the user. Hardware are the physical
components of a computer like the processor, memory devices, monitor, keyboard etc. while
software is the set of programs or instructions that are required by the hardware resources
to function properly.
There are a few basic components that aids the working-cycle of a computer i.e. the Input-
Process- Output Cycle and these are called as the functional components of a computer. It
needs certain input, processes that input and produces the desired output. The input unit
takes the input, the central processing unit does the processing of data and the output unit
produces the output. The memory unit holds the data and instructions during the processing.
Digital Computer: A digital computer can be defined as a programmable machine which
reads the binary data passed as instructions, processes this binary data, and displays a
calculated digital output. Therefore, Digital computers are those that work on the digital
data.

Details of Functional Components of a Digital Computer
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CPU

ALU
(Arithmetic
Logical Unit)

= CuU
(Control Unit)

MU
(Memory Unit)

« Input Unit : The input unit consists of input devices that are attached to the computer.
These devices take input and convert it into binary language that the computer
understands. Some of the common input devices are keyboard, mouse, joystick, scanner
etc.

« Central Processing Unit (CPU) : Once the information is entered into the computer by
the input device, the processor processes it. The CPU is called the brain of the computer
because it is the control center of the computer. It first fetches instructions from
memory and then interprets them so as to know what is to be done. If required, data is
fetched from memory or input device. Thereafter CPU executes or performs the required
computation and then either stores the output or displays on the output device. The CPU
has three main components which are responsible for different functions — Arithmetic
Logic Unit (ALU), Control Unit (CU) and Memory registers

« Arithmetic and Logic Unit (ALU) : The ALU, as its name suggests performs mathematical
calculations and takes logical decisions. Arithmetic calculations include addition,
subtraction, multiplication and division. Logical decisions involve comparison of two data
items to see which one is larger or smaller or equal.

« Control Unit : The Control unit coordinates and controls the data flow in and out of CPU
and also controls all the operations of ALU, memory registers and also input/output
units. It is also responsible for carrying out all the instructions stored in the program. It
decodes the fetched instruction, interprets it and sends control signals to input/output
devices until the required operation is done properly by ALU and memory.

« Memory Registers : A register is a temporary unit of memory in the CPU. These are used
to store the data which is directly used by the processor. Registers can be of different
sizes(16 bit, 32 bit, 64 bit and so on) and each register inside the CPU has a specific
function like storing data, storing an instruction, storing address of a location in memory
etc. The user registers can be used by an assembly language programmer for storing
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operands, intermediate results etc. Accumulator (ACC) is the main register in the ALU
and contains one of the operands of an operation to be performed in the ALU.

Memory : Memory attached to the CPU is used for storage of data and instructions and
is called internal memory The internal memory is divided into many storage locations,
each of which can store data or instructions. Each memory location is of the same size
and has an address. With the help of the address, the computer can read any memory
location easily without having to search the entire memory. when a program is executed,
it’s data is copied to the internal memory ans is stored in the memory till the end of the
execution. The internal memory is also called the Primary memory or Main memory. This
memory is also called as RAM, i.e. Random Access Memory. The time of access of data is
independent of its location in memory, therefore this memory is also called Random
Access memory (RAM). Read this for different types of RAMs

Output Unit : The output unit consists of output devices that are attached with the
computer. It converts the binary data coming from CPU to human understandable form.
The common output devices are monitor, printer, plotter etc.

Interconnection between Functional Components

A computer consists of input unit that takes input, a CPU that processes the input and an
output unit that produces output. All these devices communicate with each other through a
common bus. A bus is a transmission path, made of a set of conducting wires over which data
or information in the form of electric signals, is passed from one component to anotherin a
computer. The bus can be of three types — Address bus, Data bus and Control Bus.

Following figure shows the connection of various functional components:
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The address bus carries the address location of the data or instruction. The data bus carries
data from one component to another and the control bus carries the control signals. The
system bus is the common communication path that carries signals to/from CPU, main
memory and input/output devices. The input/output devices communicate with the system
bus through the controller circuit which helps in managing various input/output devices
attached to the computer.

SMPS

A switched-mode power supply (SMPS) is an electronic circuit that converts power using
switching devices that are turned on and off at high frequencies, and storage components
such as inductors or capacitors to supply power when the switching device is in its non-
conduction state.

Switching power supplies have high efficiency and are widely used in a variety of electronic
equipment, including computers and other sensitive equipment requiring stable and efficient
power supply.

A switched-mode power supply is also known as a switch-mode power supply or switching-
mode power supply.
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Advantages of switched-mode power supplies:

« Higher efficiency of 68% to 90%

» Regulated and reliable outputs regardless of variations in input supply voltage
o Small size and lighter

o Flexible technology

« High power density

Disadvantages:

« Generates electromagnetic interference
o Complex circuit design
« Expensive compared to linear supplies

INPUT OUTPUT DEVICES

The computer will be of no use unless it is able to communicate with the outside
world. Input/Output devices are required for users to communicate with the
computer. In simple terms, input devices bring information INTO the computer
and output devices bring information OUT of a computer system. These
input/output devices are also known as peripherals since they surround the CPU
and memory of a computer system.
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Some commonly used Input/Output devices are listed in table below.

Input Output
Devices Devices
Keyboard Monitor

Mouse LCD
Joystick Printer
Scanner Plotter
Light Pen

Touch

Screen

I. Input Devices
(a) Keyboard

It is a text base input device that allows the user to input alphabets, numbers
and other
characters. It consists of a set of keys mounted on a board

Funmoﬂ K‘Ys \

Numeric
Keys

@DDDDGDDD@DDD [
[DD[D[DDBE]IGE
F_OOOO0E00E

Normal/Keys /

Direction Keys Numeric Keypad

Alphanumeric keys

It consists of keys for English alphabets, 0 to 9 numbers, and special characters like +
B/ *()etc.
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Function Keys

There are twelve function keys labeled F1, F2, F3... F12. The functions assigned
to these keys differ from one software package to another. These keys are also
user programmable keys.

Special-function Keys

These keys have special functions assigned to them and can be used only for
those specific purposes. Functions of some of the important keys are defined
below.

Enter

It is similar to the ‘return’ key of the typewriter and is used to execute a command or
program.

Spacebar

It is used to enter a space at the current cursor location.

Backspace

This key is used to move the cursor one position to the left and also delete the
character in that position.

Delete

It is used to delete the character at the cursor position.

Insert

Insert key is used to toggle between insert and overwrite mode during data entry.
Shift

This key is used to type capital letters when pressed along with an alphabet key.
Also used to type the special characters located on the upper-side of a key that
has two characters defined on the same key.

Caps Lock

Cap Lock is used to toggle between the capital lock features. When ‘on’, it locks
the alphanumeric keypad for capital letters input only.
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Control keys

Control key is used in conjunction with other keys to provide additional
functionality on the keyboard.

Alt

Also like the control key, Alt key is always used in combination with other keys to
perform specific tasks.

Esc

This key is usually used to negate a command. Also used to cancel or abort
executing programs.

Numeric Keypad

Numeric keypad is located on the right side of the keyboard and consists of keys
having numbers (0 to 9) and mathematical operators (+ & * /) defined on them.
This keypad is provided to support quick entry for numeric data.

Cursor Movement Keys

These are arrow keys and are used to move the cursor in the direction indicated
by the arrow (up, down, left, right).

(b)  Mouse

The mouse is a small device used to point to a particular place on the screen and
select in order to perform one or more actions. It can be used to select menu
commands, size windows, start programs etc.

The most conventional kind of mouse has two buttons on top: the left one being
used most frequently.

Mouse Actions

Left Click : Used to select an item.
Double Click : Used to start a program or open a file.
Right Click : Usually used to display a set of commands.

Drag and Drop : It allows you to select and move an item from one location to
another. To achieve this place the cursor over an item on the screen, click the
left mouse button and while holding the button down move the cursor to where
you want to place the ite 1se it.

\\u—
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C) Joystick

The joystick is a vertical stick which moves the graphic cursor in a direction the
stick is moved. It typically has a button on top that is used to select the option
pointed by the cursor. Joystick is used as an input device primarily used with
video games, training simulators and controlling robots

D) Scanner

Scanner is an input device used for direct data entry from the source document
into the computer system. It converts the document image into digital form so
that it can be fed into the computer. Capturing information like this reduces the
possibility of errors typically experienced during large data entry.
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I1.Output Devices

(a) Monitor

Monitor is an output device that resembles the television screen and uses a
Cathode Ray Tube (CRT) to display information. The monitor is associated with a
keyboard for manual input of characters and displays the information as it is
keyed in. It also displays the program or application output. Like the television,
monitors are also available in different sizes.

(b) Liquid Crystal Display (LCD)

LCD was introduced in the 1970s and is now applied to display terminals also. Its
advantages like low energy consumption, smaller and lighter have paved its way
for usage in portable computers (laptops).

c) Printer

Printers are used to produce paper (commonly known as hardcopy) output.
Based on the technology used, they can be classified as Impact or Non-impact
printers.

Impact printers use the typewriting printing mechanism wherein a hammer
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strikes the paper through a ribbon in order to produce output. Dot-matrix and
Character printers fall under this category.

Non-impact printers do not touch the paper while printing. They use chemical,
heat or electrical signals to etch the symbols on paper. Inkjet, Deskjet, Laser,
Thermal printers fall under this category of printers.

When we talk about printers we refer to two basic qualities associated with
printers: resolution, and speed. Print resolution is measured in terms of number
of dots per inch (dpi). Print speed is measured in terms of number of characters
printed in a unit of time and is represented as characters-per-second (cps), lines-
per-minute (lpm), or pages-per-minute (ppm).

Printer uses ink to put data on paper or transparency. There are many types of printers.
1)Dot Matrix Printer

2)Ink Jet Printer

3)Daisy Wheel Printer

4) Laser Printer

Speed of the printer is measured in cps(character per second),lpm(line per
minute),ppm(pages per minute). The quality of the printis measured in dpi(dots per inch).
Some printers can print in color also. Dot matrix, ink jet and laser printers are most
commonly used printers. Printer can be classified into two categories according to the
technologies used in them. Impact printer and non-impact printer. An impact printer uses a

22| Page




BCA1IT www.sbs.ac.in
device to press/strike something against the ribbon to put a character on the page. Dot

matrix, daisy and line printer are impact printers.

Non-impact printers print without having a mechanism to strike against a sheet of paper. Ink
jet, laser and thermal printer are non-impact printer.

Dot Matrix Printer: It uses dots to form a characters on a paper. Dots are made by pins. Dot
matrix printer is made up of steel pins which strike the paper through a inked ribbon to
create a pattern of tiny dots. The quality of print depends upon the number of steel pins in

the machine.

Daisy Wheel printer: In this type of printer, the part that puts the characters looks like a
wheel. Numbers and letters are arranged in a wheel. And the daisy wheel spins until the
correct letter is in position. Then hammer strikes the character against the ribbon, printing it

on the paper.

Line Printer: It prints a complete line of text at a time. It uses drum or chain with all the
characters in the character set on it. The drum or chain moves and prints the necessary
characters in the right place.

Ink jet printer: It prints the character using fine jet of ink which comes out from the tiny

nozzles onto the paper. The ink is kept in reservoir and fed into the firing chambers just
below each nozzle.

Laser Printer: It uses a beam of light (laser beam) to convert binary data into print. The laser

puts an electric charge in the shape of a character on the rotating drum. The dry ink or toner
stick only to the drum where it has been charged. These printers are very fast. They can print
a whole page at once.
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Thermal Printer: It uses heat to put the characters on the paper. The paper has a spacial

coating on it. The printer uses heated wires to turn the paper black. It is basically used for

taking ECG in hospital or lab.

d) Plotter

Plotters are used to print graphical output on paper. It interprets computer
commands and makes line drawings on paper using multicolored automated
pens. It is capable of producing graphs, drawings, charts, maps etc.

Computer Aided Engineering (CAE) applications like CAD (Computer Aided
Design) and CAM (Computer Aided Manufacturing) are typical usage areas for
plotters.

MEMORY

Memory is an internal storage area in a computer, which is availed to store data and
programs either permanently or temporarily. Computer memory is broadly divided into two|
groups and they are:
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=  Primary memory and
= Secondary memory

The diagrammatic representation of the classification of computer memory is shown below:

memory

primary secondary
memory memory

Classification of the Computer Memory

When the main memory holds instructions and data when a program is executing, the
auxiliary memory or secondary memory holds data and programs which are not currently in|
use and furnishes long term storage.
The primary memory and secondary memory are further classified into distinct groups andj
those are explained in the below diagram:

memory

primary secondary
memory memory

1 T J 1

I
RAM ROM magnetic magnetic optical disk USB _flash mass storage
EEPRE disk drive devices

Classification of Primary Memory and Secondary Memory

Primary memory:
Primary memory is the only type of memory which is directly accessed by the CPU. The CPU|
continuously reads instructions stored in the primary memory and executes them. Any data
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that has to be operated by the CPU is also stored. The information is transferred to various
locations through the BUS. Primary memories are of two types. They are:

= RAM

= ROM

1. RAM: It stands for Random Access Memory. Here data can be stored temporarily, so
this type of memory is called as temporary memory or volatile memory because when
power fails the data from RAM will be erased. The information stored in the RAM g
basically loaded from the computer’s disk and includes information related to the
operating system and applications that are currently executed by the processor. RAM|
is considered random access because any memory cell can be directly accessed if it
address is known. RAM is of distinct types like SRAM, DRAM, and VRAM.

2. ROM: It stands for Read Only Memory. In this, the data will be furnished by the
manufacturers regarding the system, so this information can simply be read by the
user but cannot add new data or it cannot be modified. ROMs are of distinct types:

= PROM - Programmable Read Only Memory

= EPROM - Erasable Programmable Read Only Memory

= EEPROM — Electrically Erasable Programmable Read Only Memory

Secondary memory:
Secondary memory or auxiliary memory consists of slower and less expensive device that
communicates indirectly with CPU via main memory. The secondary memory stores the data|
and keeps it even when the power fails. It is used to store or save large data or programs or
other information. The secondary storage devices are explained below:

= Magnetic disks

= Magnetic tape

= Optical disk

= USB flash drive

= Mass storage devices

1.Magnetic disks: Magnetic disks are made of rigid metals or synthetic plastic material. The
disk platter is coated on both the surfaces with magnetic material and both the surfaces can|
be used for storage. The magnetic disk furnishes direct access and is for both small and large
computer systems. The magnetic disk comes in two forms:

=  Floppy disks

= Hard disks
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2. Magnetic tape: magnetic tape is serial access storage medium and it can store a large
volume of data at low costs. The conventional magnetic tape is in reels of up to 3600 feet
made of Mylar plastic tape. The tape is one-half inch in width and is coated with magnetig
material on one side. The reel of tape is loaded on a magnetic tape drive unit. During any
read/write operation, the tape is moved from one spool to another in the same way as in the
audiocassette tape recorder. The magnetic tape is densely packed with magnetic spots in|
frames across its width.

3. Optical drives: optical drives are a storage medium from which data is read and to which it
is written by lasers. Optical disks can store much more data up to 6GB. Optical store devices
are the most widely used and reliable storage devices. The most widely used type of opticall
storage devices are explained below:

= CD-ROM

= DVD-ROM

= CD-RECORDABLE

= CD-REWRITABLE

= PHOTO-CD

4. USB flash drives: USB flash drives are removable, rewritable and are physically much|
smaller drives, which have the weight of less than 30g. In the year of 2010, the storage
capacity of the USB flash drives was as large as 256GB. Such devices are a good substitute for
floppy disks and CD — ROMs as they are smaller, faster, have thousands of times more
capacity, and are more durable and reliable. Until 2005, most desktop and laptop computers
had floppy disk drives, but nowadays floppy disk drives have been abandoned in favor of USB]
ports. The USB connector is often protected inside a removable cap, although it is not likely]
to be damaged if unprotected. USB flash drives draw power from the computer through|
external USB connection. The most widely used USB flash drives are the memory cards.

5. Mass storage devices: Mass storage devices refer to the saving of huge data in a persistent
manner. Mass storage machines can store up to several trillion bytes of data and hence are
used to store or save large databases, such as the information of customers of a big retaill
chain and library transactions of students in a college. Some of the commonly used mass
storage devices are explained below:

= Disk array

= Automated tape

= CD-ROM jukebox

Number System
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The technique to represent and work with numbers is called number system. Decimal
number systemis the most common number system. Other popular number systems
include binary number system, octal number system, hexadecimal number system, etc.

When we type some letters or words, the computer translates them in numbers as
computers can understand only numbers. A computer can understand the positional
number system where there are only a few symbols called digits and these symbols
represent different values depending on the position they occupy in the number.

The value of each digit in a number can be determined using —
o The digit
o The position of the digit in the number

o The base of the number system (where the base is defined as the total number of
digits available in the number system)

Decimal Number System

The number system that we use in our day-to-day life is the decimal number system.
Decimal number system has base 10 as it uses 10 digits from 0 to 9. In decimal number
system, the successive positions to the left of the decimal point represent units, tens,
hundreds, thousands, and so on.

Each position represents a specific power of the base (10). For example, the decimal number
1234 consists of the digit 4 in the units position, 3 in the tens position, 2 in the hundreds
position, and 1 in the thousands position. Its value can be written as

(1 x 1000)+ (2 x 100)+ (3 x 10)+ (4 x |)
(1 x 10%)+ (2 x 10%)+ (3 x 10Y)+ (4 x 10°)
1000 +200+30+4

1234

As a computer programmer or an IT professional, you should understand the following
number systems which are frequently used in computers.

S.No. Number System and Description

1 Binary Number System

Base 2. Digits used : 0, 1
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Octal Number System
Base 8. Digits used : 0to 7

Hexa Decimal Number System

Base 16. Digits used: 0 to 9, Letters used : A- F

Binary Number System

The easiest way to vary instructions through electric signals is two-state system — on and off.
On is represented as 1 and off as 0, though 0 is not actually no signal but signal at a lower
voltage. The number system having just these two digits — 0 and 1 —is called binary number
system.

Each binary digit is also called a bit. Binary number system is also positional value system,
where each digit has a value expressed in powers of 2, as displayed here.

25 24 23 22 21 20

In any binary number, the rightmost digit is called least significant bit (LSB) and leftmost
digit is called most significant bit (MSB).

MSB LSB

And decimal equivalent of this number is sum of product of each digit with its positional
value.

11010, = 1x2%+ 1x23 + 0x22 + 1x2! + 0x2°
=16+8+0+2+0
= 2610

Example
Binary Number: 10101,
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Calculating Decimal Equivalent -

Step Binary Number Decimal Number

Step 1 10101, (Ax2%)+(0x23)+(1x2%)+(0x2Y) +(1x2%)10
Step 2 10101, (16+0+4+0+1)10
Step 3 10101, 2140

Note - 10101; is normally written as 10101.

Octal Number System
Characteristics of the octal number system are as follows -
« Uses eight digits, 0,1,2,3,4,5,6,7
« Also called as base 8 number system
« Each position in an octal number represents a 0 power of the base (8). Example 8°

o Last position in an octal number represents a x power of the base (8). Example
8 where x represents the last position — 1

Octal number system has eight digits—0, 1, 2, 3, 4, 5, 6 and 7. Octal number system is also a
positional value system with where each digit has its value expressed in powers of 8, as
shown here -

85 84 83 g2 g1 80

Decimal equivalent of any octal number is sum of product of each digit with its positional
value.

7265 = 7x8% + 2x8' + 6x8°
=448 +16+6
= 47010
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Example
Octal Number: 125703

Calculating Decimal Equivalent -

Step Octal Number Decimal Number
Step 1 12570s (1x8%)+(2x8%)+(5x8%)+(7x8)+(0x8%)w0
Step 2 12570s (4096 + 1024 + 320 + 56 + 0)10
Step 3 12570s 549610

Note — 12570s is normally written as 12570.

Hexadecimal Number System

Octal number system has 16 symbols — 0 to 9 and A to F where A is equal to 10, B is equal to
11 and so on till F. Hexadecimal number system is also a positional value system with where
each digit has its value expressed in powers of 16, as shown here -

165 16% 163 162 161 169

Decimal equivalent of any hexadecimal number is sum of product of each digit with its
positional value.

27FB16 = 2x16% + 7x16% + 15x16' + 10x16°
=8192 + 1792 + 240 +10
=1023410

Example
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Hexadecimal Number: 19FDEs

Calculating Decimal Equivalent -

Step

Step 1

Step 2

Step 3

Step 4

Binary
Number

19FDE1s

19FDE e

19FDE 6

19FDE 6

Decimal Number

((1x16% + (9 x 16%) + (F x 162) + (D x 16%) + (E x 169))10

((1x 16%) + (9 x 16%) + (15 x 162) + (13 x 16*) + (14 x 16°))10

(65536+ 36864 + 3840 + 208 + 14)10

10646210

Note — 19FDE6 is normally written as 19FDE.

Conversions

There are many methods or techniques which can be used to convert numbers from one
base to another. We'll demonstrate here the following -

Decimal to Other Base System

o Other Base System to Decimal

o Other Base System to Non-Decimal

o Shortcut method - Binary to Octal

o Shortcut method - Octal to Binary

o Shortcut method - Binary to Hexadecimal

o Shortcut method - Hexadecimal to Binary
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Decimal to Other Base System
Steps

o Step 1 - Divide the decimal number to be converted by the value of the new base.

« Step 2 - Get the remainder from Step 1 as the rightmost digit (least significant digit) of
new base number.

« Step 3 - Divide the quotient of the previous divide by the new base.

« Step 4 - Record the remainder from Step 3 as the next digit (to the left) of the new
base number.

Repeat Steps 3 and 4, getting remainders from right to left, until the quotient becomes zero
in Step 3.

The last remainder thus obtained will be the Most Significant Digit (MSD) of the new base
number.

Example -
Decimal Number: 2919

Calculating Binary Equivalent -

Step Operation Result Remainder
Step 1 29/2 14 1
Step 2 14 /2 7 0
Step 3 7/2 3 1
Step 4 3/2 1 1
Step 5 1/2 0 1
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As mentioned in Steps 2 and 4, the remainders have to be arranged in the reverse order so

that the first remainder becomes the Least Significant Digit (LSD) and the last remainder
becomes the Most Significant Digit (MSD).

Decimal Number — 2910 = Binary Number - 11101,.

Other Base System to Decimal System

Steps

o Step 1- Determine the column (positional) value of each digit (this depends on the
position of the digit and the base of the number system).

o Step 2- Multiply the obtained column values (in Step 1) by the digits in the
corresponding columns.

o Step 3 - Sum the products calculated in Step 2. The total is the equivalent value in
decimal.

Example
Binary Number - 11101,

Calculating Decimal Equivalent -

Step  Binary Number Decimal Number

Step1 11101, (1% 2%) + (1 x 23) + (1 x 22) + (0 x 21) + (1 x 29)10

Step2 11101, (16+8+4+0+1)10

Step3 11101, 2910

Binary Number — 11101, = Decimal Number - 2919

Other Base System to Non-Decimal System

Steps

« Step 1 - Convert the original number to a decimal number (base 10).

« Step 2 - Convert the decimal number so obtained to the new base number.
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Octal Number - 255

Calculating Binary Equivalent -

Step 1 -

Step

Step 1

Step 2

Step 3

Convert to Decimal

Octal Number Decimal Number
25s ((2x 8" +(5x 8o
258 (16 + 5 )10
253 2110

Octal Number - 255 = Decimal Number - 2119

Step 2 -

Step

Step 1

Step 2

Step 3

Step 4

Step 5

Convert Decimal to Binary

Operation Result
21/2 10 1
10/2 5 0
5/2 2 1
2/2 1 0
1/2 0 1

Decimal Number - 2110 = Binary Number - 10101,
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Octal Number - 255 = Binary Number - 10101,

Shortcut method - Binary to Octal

Steps
« Step 1 - Divide the binary digits into groups of three (starting from the right).
» Step 2 - Convert each group of three binary digits to one octal digit.

Example
Binary Number - 10101,

Calculating Octal Equivalent -

Step Binary Number Octal Number
Step1 10101, 010101
Step2 10101, 25 53
Step3 10101: 258

Binary Number — 10101, = Octal Number - 253

Shortcut method - Octal to Binary
Steps

« Step 1- Convert each octal digit to a 3 digit binary number (the octal digits may be
treated as decimal for this conversion).

« Step 2 - Combine all the resulting binary groups (of 3 digits each) into a single binary
number.

Example
Octal Number — 25¢

Calculating Binary Equivalent -
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Step Octal Number Binary Number
Step1l 253 210 510

Step2 25s 010: 101,

Step3 25s 010101;

Octal Number - 25g = Binary Number - 10101,

Shortcut method - Binary to Hexadecimal
Steps
« Step 1 - Divide the binary digits into groups of four (starting from the right).

« Step 2 - Convert each group of four binary digits to one hexadecimal symbol.

Example
Binary Number - 10101,

Calculating hexadecimal Equivalent -

Step Binary Number Hexadecimal Number
Step1 10101, 0001 0101

Step 2 10101, 110 510

Step3 10101, 1516

Binary Number - 10101, = Hexadecimal Number — 151¢

Shortcut method - Hexadecimal to Binary

Steps
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« Step 1- Convert each hexadecimal digit to a 4 digit binary number (the hexadecimal
digits may be treated as decimal for this conversion).

« Step 2 - Combine all the resulting binary groups (of 4 digits each) into a single binary
number.

Example
Hexadecimal Number - 1516

Calculating Binary Equivalent -

Step Hexadecimal Number Binary Number
Step1l 1516 110 510
Step2 1516 0001, 0101,

Step3 1516 00010101,

Hexadecimal Number - 1516 = Binary Number — 10101,
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Applications of Information Technology

Every day, people use computers in new ways. Computers and other electronic devices are
becoming increasingly affordable. They continue to be more powerful as information-
processing tools as well as easier to use. Humans are continually becoming dependant on IT-
enabled devices for carrying out simple tasks like remembering a phone number to complex
ones like flying a fighter plane. Information Technology has applications in almost all aspects
of our life. Some of the important ones are:

Science and Engineering: Scientific progress in fields like biotechnology is almost entirely
dependent on the use of computers and other microprocessor-controlled devices. Using
supercomputers, meteorologists predict future weather by using a combination of
observations of weather conditions from many sources, a mathematical representation of
the behaviour of the atmosphere, and geographic data. Computer-aided design (CAD) andj
computer-aided manufacturing (CAM) programs have led to improved products in many
fields, especially where designs tend to be very detailed. Computer programs make it
possible for engineers to analyse designs of complex structures such as power plants and]
space stations.

Business & Commerce: One of the first and largest applications of computers is keeping and
managing business and financial records. Most large companies keep the employment
records of all their workers in large databases that are managed by computer programs.
Similar programs and databases are used in business functions like billing customers; tracking
payments received and payments to be made; and tracking supplies needed and items
produced, stored, shipped, and sold. In fact, practically all the information companies need toj
do business involves the use of computers and Information Technology. Almost all the
financial transactions in the world are done electronically. Newer technologies like m-
commerce have enabled almost everybody to carry out routine financial transactions on the
move.

On a smaller scale, many businesses have replaced cash registers with point-of-sale (POS)
terminals. These POS terminals not only print a sales receipt for the customer but also send
information to a computer database when each item is sold to maintain an inventory of items
on hand and items to be ordered. Computers have also become very important in modern
factories. Computer-controlled robots now do tasks that are hot, heavy, or hazardous. Robots
are also used to do routine, repetitive tasks in which boredom or fatigue can lead to poor
quality work.

With today's sophisticated hardware, software, and communications technologies, it is often|
difficult to classify a system as belonging uniquely to one specific application program.
Organizations increasingly are consolidating their information needs into a single, integrated|]
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information system. Management Information System (MIS), with the Chief Information|
Officer (ClO) at its head, is a whole, new branch of enterprise management.

Education: The advent of Information Technology has changed the meaning of the term|
“literate”, with computer literacy being almost as important as basic literacy in many cases.
Computer education is an essential course at the primary level in most schools across the
world. With more Information getting digitized every day, and the internet making it
accessible to anyone across the world, students are increasingly relying on electronic sources|
of information rather than physical libraries for their needs. Instructional methodology has
also undergone a sea change with use of images, animations, videos, presentations and e-
learning to complement traditional techniques.

Governance: The concept of e-governance is one of the most novel applications of
Information Technology whereby it is changing the lives of millions across the globe.
Computerization of Government activities makes it easier to supervise and audit, and makes
the administration more responsive to the needs of society. It also bridges the divide
between the Government and the people. Technologies like touch-screen kiosks help|
disseminate information on land records, photo identity cards, pending bills etc. and enable
even illiterate people to take more informed decisions. India is leading the world in the
effective use of IT for elections.

Medicine: Information Technology plays an important role in medicine. For example, a|
scanner takes a series of pictures of the body by means of computerized axial tomography
(CAT) or magnetic resonance imaging (MRI). A computer then combines the pictures to|
produce detailed three-dimensional images of the body's organs. In addition, the MRI
produces images that show changes in body chemistry and blood flow. Most critical life
support equipment are programmed to respond to changes in the patient’s status in split-
seconds, thereby reducing the response time and risk of human error. Newer concepts like
robotic surgery enable specialists to perform surgeries from remote locations. Genomig
studies greatly depend on supercomputing power to develop technologies for the future.

Entertainment: IT has changed the lifestyle of most people. The convergence of various
technologies has created various options for entertainment like games, streaming music andj
video, digital television broadcasts, satellite radio, animated movies etc. which can be
accessed with the help of mobile phones, PDAs, notebook computers or on television either
with a cable connection or wirelessly using newer-generation WiFi, CDMA or GPRY
technologies.
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Information Technology plays a vital role in most of our daily activities. There is hardly
anyone who has not been affected or influenced by IT. With each passing day, newer
applications of IT are being developed which increase our interaction with and dependence
on IT-enabled devices. Therefore, understanding this technology and using it creatively is
imperative to human progress.

UNIT-2
Introduction:

A language is the main medium of communicating between the Computer systems and the
most common are the programming languages. As we know a Computer only understands
binary numbers that is 0 and 1 to perform various operations but the languages are
developed for different types of work on a Computer. A language consists of all the
instructions to make a request to the system for processing a task. From the first generation
and now fourth generation of the Computers there were several programming languages
used to communicate with the Computer. Here we will go in the detail of the Computer
language and its types.

Computer Language Description:

A Computer language includes various languages that are used to communicate with a
Computer machine. Some of the languages like programming language which is a set of
codes or instructions used for communicating the machine. Machine code is also considered
as a computer language that can be used for programming. And also HTML which is a
computer language or a markup language but not a programming language. Similarly there
are different types of languages developed for different types of work to be performed by
communicating with the machine. But all the languages that are now available are
categorized into two basic types of languages including Low-level language and High level
language.
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High Level Language

FORTR:\h C\‘ PASCAL

High Level Language

ra—

Assembly Language

Low Level Language =

Machine Language

Hardware

Computer Language and its Types

Low Level Language:

Low level languages are the machine codes in which the instructions are given in machine
language in the form of 0 and 1 to a Computer system. It is mainly designed to operate and
handle all the hardware and instructions set architecture of a Computer. The main function
of the Low level language is to operate, manage and manipulate the hardware and system
components. There are various programs and applications written in low level languages that
are directly executable without any interpretation or translation. The most famous and the
base of all programming languages “C” and “C++” are mostly used Low level languages till
today. Low level language is also divided into two parts are Machine language and Assembly
language.

= Machine Language is one of the low-level programming languages which is the first
generation language developed for communicating with a Computer. It is written in
machine code which represents 0 and 1 binary digits inside the Computer string which
makes it easy to understand and perform the operations. As we know a Computer
system can recognize electric signals so here 0 stands for turning off electric pulse and 1
stands for turning on electric pulse. It is very easy to understand by the Computer and
also increases the processing speed.
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The main advantage of using Machine language is that there is no need of a translator or
interpreter to translate the code, as the Computer directly can understand. But there are
some disadvantages also like you have to remember the operation codes, memory address
every time you write a program and also hard to find errors in a written program. It is a
machine dependent and can be used by a single type of Computer.

= Assembly Language is the second generation programming language that has almost
similar structure and set of commands as Machine language. Instead of using numbers
like in Machine languages here we use words or names in English forms and also
symbols. The programs that have been written using words, names and symbols in
assembly language are converted to machine language using an Assembler. Because a
Computer only understands machine code languages that’s why we need an Assembler
that can convert the Assembly level language to Machine language so the Computer
gets the instruction and responds quickly.

The main disadvantage of this language is that it is written only for a single type of CPU and
does not run on any other CPU. But its speed makes it the most used low level language till
today which is used by many programmers.

High Level Language:

The high level languages are the most used and also more considered programming
languages that helps a programmer to read, write and maintain. It is also the third generation
language that is used and also running till now by many programmers. They are less
independent to a particular type of Computer and also require a translator that can convert
the high level language to machine language. The translator may be an interpreter and
Compiler that helps to convert into binary code for a Computer to understand. There is
various high level programming languages like C, FORTRAN or Pascal that are less
independent and also enables the programmer to write a program.

UNIT-II

Mainly there are two types of computer languages
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Low Level Computer Languages

These are machine codes or close to it. Computer cannot understand instruction given in high
level languages or in English. It can only understand and execute instructions given in the
form of machine languages i.e. the binary number 0 and 1. There are two types of low level
computer language.

Machine Language

A machine language consists of the numeric codes for the operations that a particular
computer can execute directly. The codes are strings of Os and 1s, or binary digits (“bits”),
which are frequently converted both from and to hexadecimal (base 16) for human viewing
and modification. Machine language instructions typically use some bits to represent
operations, such as addition, and some to represent operands, or perhaps the location of the
next instruction. Machine language is difficult to read and write, since it does not resemble
conventional mathematical notation or human language, and its codes vary from computer
to computer.

The set of binary codes which can be recognize by the computer is known as the machine
code instruction set. A machine language instruction consists of an operation code one or
more operands. The operation code specifies that operation that is to be performed e.g.
read, record etc. the operands identify the quantities to be operated on e.g. the numbers to
be added or the locations where data are stored. But, it is almost impossible to write
programs directly in machine code. For this reason, programs are normally written in
assembly or high level languages and then are translated in the machine language by
different translators.

1. It makes fast and efficient use of the computer

It requires no translator to translate the code i.e. directly understood by the
computer.

All operation codes have to be remembered

All memory addresses have to be remembered

It is hard to amend or find errors in a program written in the machine language
These languages are machine dependent i.e. a particular machine language can be
used on only one type of computer.

Assembly Languages

It was developed to overcome some of the many inconveniences of machine language. This is
another low level but a very important language in which operation codes and operands are
given in the form of alphanumeric symbols instead of 0’s and 1’s. These alphanumeric
symbols will be known as mnemonic codes and can have maximum up to 5 letter
combinations e.g. ADD for addition, SUB for subtraction, START LABEL etc. because of this
feature it is also known as “Symbolic Programming Language”. This language is very difficult

N
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and needs a lot of practice to master it because very small English support is given. This
symbolic language helps in compiler orientations. The instructions of the assembly language
will also be converted to machine codes by language translator to be executed by the
computer

It is easier to understand and use as compared to machine language

It is easy to locate and correct errors

It is modified easily

Like machine language it is also machine dependent

Since it is machine dependent, there programmer should have the knowledge of he
hardware also.

NP W e

[ High-Level Languages (Basic, Java, FORTRAN) ]

[ low-Level Languages ] Compiler or

Interpreter
Assembler
[ Machine Code (Binary) ]
[ Hardware ]
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Word processing describes the process of creating or editing a document using a word

processor, such as Microsoft Word, Google Docs, or OpenOffice Writer. For example, with a

word processor, a student could create a book report and then print it, save it to a disk,

display it on the screen, or send it over e-mail. Also, a person looking for a job could create a

résumé using a word processor, then e-mail or print and mail it to job recruiters.
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Menu bar

Menu bar This is the traditional windows style drop-down menu. When you point to any
menu title and click once with the mouse, the menu will open displaying all the commands
available under this menu. Clicking on the desired command would tell Word to execute
that command. Some commands have ellipses (...) in front of them. These commands have
further sub commands. Commands appearing in dim mode cannot be executed unless the
prerequisite functions required by that command have been performed, e.g. you cannot use
the Copy or Cut command from the Edit menu unless you have selected a piece of text first.
Many commands also have a keyboard shortcuts specified against their names.

Standard toolbar

Standard toolbar Toolbars contain buttons, drop-down menus and other controls that help|
you to quickly alter the appearance and arrangement of documents by executing a variety of
word commands. Toolbars are very helpful and convenient in quickly executing commands|
without having to go through menus. The standard toolbar contains icons for basic functions
like opening files, saving files, printing files, cut, copy, paste etc.

Formatting toolbar

This contains icons for changing the look of your text (called “formatting” in computer
jargon); for example, there are icons for changing fonts, styles, font sizes, text alignment etc.

Ruler

The Ruler lets you make changes to margins and indents, and helps you create document as
per dimensions required.

Scroll tools
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These helps you travel within your document. You can go anywhere, up and down, right and
left in your document mainly by two ways: Using the horizontal and vertical scroll bars with|
the help of the mouse; Or using the keyboard to press PgUp, PgDn, Home, End and arrow
keys.

Status bar

Also called the Status Area, this is the normally the last line on your screen. This gives the
following information about your work—

e Current Page

e Section Number

e Current/Total pages in the document

e Current Cursor Position (where the cursor is presently located)

e Current Line Number

e Current Column Number

e Record Macro-whether macro recording is On or not

e Track Revision-whether revisions have been made or not

e Extend Selection

e Over type mode-whether you are in Insert mode or overwrite mode

Cursor

Also called the Insertion Pointer, this denotes the place where text, graphics or any other
item would be placed when you type, overwrite or insert them. This looks like a tall, skinny|
toothpick and keeps blinking so that you can locate it easily.

Mouse pointer

When your mouse pointer looks like an I-beam you should be able to move it freely on the
screen. This is used for either placing the cursor at the desired place (take the mouse pointer
there and click) or choosing any command either from the menu or from toolbars. The mouse
pointer changes shape when in the process of doing certain tasks and the cursor disappears.
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File management

Creating a New Document

@)
@)

O

Click on File Menu
Select and click New option

Otherwise click | [ button on the standard toolbar

e Opening an ExistingDocument:

O
O

O
O

Click File Menu
Select and click Open option

Otherwise click Ii" button on the Standard toolbar.
Double click on the file from the open window

e Saving a Document

O

O

O

Click File Menu
Select and click Save button.

Otherwise click button ] | on the Standard toolbar.

e Moving through thedocument
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Open any word document. You can move the cursor to any location
on the screen by using the arrow keys on the keyboard.

Right arrow key is used to move one position to the right of the
cursor

Left arrow key is used to move one position to the left of the
cursor.

Up arrow key is used to move one position to the top of the
cursor.

Down arrow key is used to move one position to the down of
the cursor.

Page Up key is used to move down the screen ata time
Page down key is used to move up the screen at a time

Hold down Ctrl key and press Home to move to beginning of the




BCA1IT www.sbs.ac.in

document.
o Hold down Ctrl key and press End to move to end of the
document.

Editing Word document

e Cut, Copy and Paste options

= These options will allow you to Cut or Copy a piece of text
from one location and to paste at a new location.

e To do these functions,

o Place the cursor at the begining of the text to be selected. Drag the
mouse pointer over the text. The text will now appear in reverse
vedeo as shown below:

(Il awahar Knowledge Center
b

o Click Edit menu and then click on Cut option (or) click —
icon on the Standard Toolbar. Move the cursor to the place
where you want the text to be pasted.

o Click Edit menu and then click Paste option (or) click =
icon on the Standard Toolbar.

e For copying the text from one location to other location the same
procedure is to be followed. The difference between Cut and Copy is that
while using the Cut option the text will be removed from its original
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location and pasted at a new location, where as when using Copy option a
copy of the selected text is pasted at new location without disturbing the
original text.
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Searching text

Open any document.
Click Edit menu and then click Find option. You will get a screen as
shown below.

Find and Replace

Find Replace | GoTo

Find what: w

[ Highlight all items Found in:

More ¥ Zancel

In Find What text box type the word you want to find and then
click Find Next button.

Continue clicking Find Next button until you get the screen shown
below.

Click OK button and then click X to close Find and Replace
dialog box.

Replacingtext

=l

Open any word document.

Click Edit menu and then click Replace option. You will get the
dialog box as shown below and type the word with which you
want to replace.
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Find and Replace

Find | Replace | Ga To

Find whak; | L |

Replace with: | W |

Mare ¥ Cancel

Click ReplaceAll button once. You get the below dialog box.

Microsoft Office Word

f» 4 ‘Word has Finished searching the selection. 0 replacements were made. Do yvou want o search the remainder of
\-‘:/ the document?

Click OK button and then click X to close Find and Replace
dialog box.

Moving the cursor to a specific page
If your word document contains more than one page, you can

directly go to specified page by clicking Edit menu and then
clicking Go To option. You will get the dialog box as shown below.
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Find and Replace

Find Reglace| Go To |

Go ko what; Enter page number:
Page s
Seckion F
Line Enter + and — to move relative to the current
Bookmark = lacation. Example: +¢ will move Farward Four
Comment itemns.
Foaktnote
Endnote had -
Presious ] [ Mext ] [ Close
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In the Enter page number text box, type the required page
number as shown below.

Find | Replace | GoTo

Go ko what: Enter page number:

A~ 4

Section

Line Enter + and — ko move relative to the current
Bookmark location, Example: +< will move Farward Four
Comment items.

Fooktnote

Endnote b [ l [

Go Ta Close

Click Go To button. Cursor will immediately jump to page 4.
Click Close button to close Find and Replace dialogbox.

Formatting documents

12| Page

Bold, Underline and Italicize the selected text

Open a word document.

Block the text by first clicking at the start of the text and holding
the left mouse button and drag to the desired position and then
release the left mouse button. The selected area will be
highlighted.

Move the mouse pointer to the button B on the Standard
Toolbar and click once.

Move the mouse pointer outside your text and click to release the
highlighting. Your text will now appear in BOLD FACE.

Like this you can underline or italicize the desired text by using the
following buttons

L0




BCA1IT www.sbs.ac.in

Left aligning, centering , right aligning and justifying text

Left Centre Right Justify

e Open a word document.

e Block the text by first clicking at the start of the text and holding the left
mouse button and drag to the desired position and then release the left
mouse button. The selected area will be highlighted.

e Move the mouse pointer to Align Left button on the toolbar and click
once. Your selected text will be left aligned.

e Move the mouse pointer to Align right button on the toolbar and click
once. Your selected text will be right aligned.

e Move the mouse pointer to Center button on the toolbar and click once.
Your selected text will be centered.

e Move the mouse pointer to Justify button on the toolbar and click once.
Your selected text will be justified.

Creating Bulleted and Numberedlist

o If a list of items are to be numbered automatically it can be done
using Numbered List option

e Ex: Microsoft Office
consists of MS-Word

e MS-Excel

e MS-PowerPoint
MS-Access

e MS-Outlook

O

The above text is to be selected with mouse.
Click on the Numbered List button on the toolbar i=

O

o Move out of the text and click to release the highlighting.
Your text will now look like this

O

= MS-Word
13| Page
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=  MS-Excel

= MS-PowerPoint
= MS-Access

=  MS-Outlook

o Now re-select the text

o Click the Bulleted List button on thetoolbar.

www.sbs.ac.in
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The numbers should be replaced with bullets as shown below

MS-Word
MS-Excel
MS-PowerPoint
MS-Access
MS-Outlook

Indenting Paragraphs

Select a paragraph with the mouse.
Click on the Right (increase) Indent i= button on the
toolbar.

Leave the highlighting on and click once more on the Right Indent
button.

Click once on the Left Indent button. Your text
should now be indented by one Tab stop. Each time you click, the
paragraph is moved one tab stop.

s

Changing case of text

You can change the selected text into either UPPERCASE,
lowercase, Title case or tOGGLE cASE

Highlight the text. Select the Format menu option
Choose Change Case option. You will get the dialog box shown
below.

]
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Change Case @

() Sentence case.
O lowercase
() UPPERCASE!

) Title Case
) tOGGLE cASE

[ OK ][ Cancel ]

From the list of options select UPPERCASE to convert lower case
into uppercase
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Indenting text with tabs

www.sbs.ac.in

Type your name and address as you would at the head of a letter,
but aligned with the left margin e.g.

K.Manohar H.No

10-334/3,
V.P. Nagar,
Malakpet,
Hyderabad.

Move the cursor to the start of each line and press the Tab key.
Just as with the right indent button, your text will move right.
How much it moves will depend on the tab settings, which you
can change in the Format, Tabs menu as shown below.

Tah stop position:

Alignmment

() Left
) Decimal

Leader

@'anne
Oa___

Default kab stops:
D.S“ ¢

Tab stops to be cleared:

() Center ) Right:
) Bar
Oz Cg-—

Clear all

04 ][ Zancel ]

Font Controlling

To get different character styles we can change Font type
Click on Format menu
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Select Font option. You will get the following screen.
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Font

Font Character Spacing || Texk Effects
Latin kext Font: Font skwle:

imes Mew Faman * | |Fegular

Reqular ____JEYIpLE A

Italic 11
Biald W 12
Comples scripks
Fonk: Font style: Size
Times Mew Rarman » | |Regular W12 b d
All bext
Fonk colar: ndertling skyle:
Automatic % | | {none) w
Effects
[] strikethraugh [ ] shadow [ 5mall caps
[] Double strikethraugh [] outline [ all caps
[] superscript [] Emboss ] Hidden
[] subseript []Engrave
Prewview
sample — e el e
Thiz is a TruaTwpe Font, This Font will be uzed on both printer and screen,
Default, ., [ I ] [ Cancel

You can set Font type, Font Style and Font size and Color

of the selected text.
Click OK button.

Note: The above options are also available on the

Formatting Toolbar

Mormal * Werdana 12 =

Font style Font Type Font size

4

Color
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MAIL MERGE

Mail merge is a feature within most data processing applications that enables
users to send a similar letter or document to multiple recipients. It enables
connecting a single form template with a data source that contains information
about the recipient’s name, address and other predefined and supported data

Mail merge primarily enables automating the process of sending bulk mail to
customers, subscribers or general individuals. Mail merge works when a data file
is stored that includes the information of the recipients to whom the letter is to
be sent. This file can be a spreadsheet or database file containing separate fields
for each different type of information to be merged within the letter.

The second file is the word document or the letter template. The recipients'
information on the letter template is kept empty. When the mail merge process is
initiated, the recipients' data from spreadsheet or database is fetched and placed
within the empty field in the letter, one by one, until all letters are created.

Steps To Perform Mail Merging

1. In a blank Microsoft Word document, click on the Mailings tab, and in
the Start Mail Merge group, click Start Mail Merge.
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Home Insert Design Layout References

Envelopes Labels |Start Mail
Merge -

Select Edit Highlight Address
Recipients ~ Recipient List | Merge Fields Elocl
~atart Mail Merge

Create

1. Click Step-by-Step Mail Merge Wizard.

o G

Start Mail  Select Edit High
Merge = | Recipients = Recipient List | Merge
2] Letters

£ E-mail Messages

E1 Envelopes.

T Labels...

E] Directory

El Mormal Word Document

@p-b}f-ﬁtep Mail Merge ﬂsz)

2. Select your document type. In this demo we will select Letters. Click Next:
Starting document.

21| Page

Greet
Lire
Write .
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Mail Merge v X

Select document type
ument are

What typ. =

Step 1 of 6

3. Select the starting document. In this demo we will use the current (blank)
document. Select Use the current document and then click Next: Select

recipients.
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Mail Merge v X

Select starting document

Howr do you want to set up

Use the current document

Start from the dooument
hown here and use the Ma
Merge wizard to add

reciplent information

Step 2of b

Note that selecting Start from existing document (which we are not
doing in this demo) changes the view and gives you the option to choose
your document. After you choose it, the Mail Merge Wizard reverts

to Use the current document.
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4. Select recipients. In this demo we will create a new list, so select Type a
new list and then click Create.

Mail Merge v X

Select recipients

Type a new list
Type the names and

addresies of recipients
o
Step 3 of &
=» Mext: Write your letter
#= Prewvious: Starting dooument
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o Create a list by adding data in the New Address List dialog box and

clicking OK w
New Address List [ 2 jmsem
Type recipient information in the table. To add more entries, click New Entry.
Title | First bame {l st-blam l|r“ nnnnn Mame w | Address Line 1 v|
Fl [ »
| Mew Entry | | Find... |
| Delete Entry | | Customize Columns. .. | ([ QK -DI Cancel
s

o Save the list.

o Note that now that a list has been created, the Mail Merge Wizard
reverts to Use an existing list and you have the option to edit the
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recipient list.

Mail Merge v X

Select rec ii icnts

select from Qutlook contacts

ype 8 revr list

Use an existing list

Currently, your recipients are
elected from.

[Office Address List) in “address-l

Step 3of b
=¥ Mext | our ter
L= ous! Start oCumEr

o Selecting Edit recipient listopens up theMail Merge
Recipients dialog box, where you can edit the list and select or
unselect records. Click OK to accept the list as is.
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Mail Merge Recipients

LT o |

This is the list of recipients that will be used in your merge, Use the options below to add to or change your list.
Use the checkboxes to agd or remove recipients from the merge. When your list is ready, click QK.

Data Source “

- First Mame - Titha - C-HTIFIH'I,' Mama - Oorec
address-list.mdb : Rollimg Stones
address-list.mdb Relling Stomes 23 Mag

T| m
Data Source Befine recipient list
address-list.mdb - 5 Sarl. :

‘:| Fitter..,
(¥4 Find duplicates. .
& Find recipient..

[} Validate addresses..,
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o Click Next: Write your letter.

Mail MMerge -

Sclboect roedcipicnts

=) Use an existing list

s an existinag list

Curremnt WO LT echplemts are
elected From
[OFfice Address Listl] in “address-|
] = t = | it t
L~ E ecipie I

Step 3 _ =

“— Prewious: Startimg doocument

5. Write the letter and add custom fields.
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o Click Address block to add the recipients' addresses at the top of the

o In the Insert Address Block dialog box, check or uncheck boxes and select

document.

Mail Merge e

Write your letter

B o hiave mot already done
20, WilE Four TEThEr maw,

To add recipient infaormati-on
to your letter, dick a location
im the document, and then

click nni ilIII |IIr-|-\. Belonr,
—

=1 Elec

Grasting lime. .

onic postage...

ES raore items..

When you have finished
wirrtinmg your letter, click Mext.
Then youw can previeww and
persamalize each recipient’s

letier.

Step 4 of &

== Mext: Preview your letters

4= Frewious: Select recipients

options on the left until the address appears the way you want it to.

Insert Address Block

A=)

Specify ad
| Insert recipient’s name In this format:

Joshua

laskua Ramdall b,
Joshua €}, Randall Jr,
M. Josh Randall Jr

Insert company name

(| Insert postal address:

Mr, Jash Q. Randall Jr.
bdir. lnshusa Bandali ir.

Previgw
Here is & préview Trom your recipient list:

1 I [

Mick Jagger
Rolling Stomes
11 Elm St., Sticky Fingers, TX 11111

0 Mever include the country/region in the address
Ahyays indude the countryg/region in the address
@ Only include the cowntry/region if different tham:

Correct Problems

United States

[=]

your mailing list.
|of| Format address according to the destination m@ ‘m' |

If items in your address block are missing or out of order, use
Match Fields to identify the correct address elements from

“.I k Cancel
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o Note that you can use Match Fieldsto correct any problems.
Clicking Match Fields opens up the Match Fields dialog box, in which you can
associate the fields from your list with the fields required by the wizard.

Match Fields [ 2

In order to use special features, Mail Merge needs to know
which fields in your recipient list match to the required fields.
Use the drop-down list to select the appropriate recipient list
field for each address field component

Required for Address Block -
Courtesy Title Title [=]
First Mame First Mame =L
Last Name Last Name [=] r
Suffix {not matched] [=]
Company Company Name El
Address 1 Address Line 1 El
Address 2 Address Line 2 [=]
City City [=]
State State =]
Postal Code ZIP Code [=]
Country or Region Country or Region IZ|

Ootional information

Use the drop-down lists to choose the field from your database
that corresponds to the address information Mail Merge
expects (listed on the left.)

Bemember this matching for this set of data sources on this
computer

ook Y [ cancel

6. Press Enter on your keyboard and click Greeting line... to enter a greeting.

MMail Merge - =

Write your better

I you have mot alre
P sy t

Step 4 of 6

#— Prewiowus: Select recipiemts
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7. In the Insert Greeting Line dialog box, choose the greeting line format by
clicking the drop-down arrows and selecting the options of your choice, and
then click OK.

Insert Greeting Line liléj

Greeting li

[=| | Mr. Randall =] |

reeting line for invalid recipient names:

[=]

Here is a preview from your recipient list:

1 >[4

ar Sir or Madam,

Preview

Dear Mick Jagger,

Correct Problems

If items in your greeting line are missing or out of order, use Match Fields
to identify the correct address elements from your mailing list.

Match Fields...

C o D[ cone
e —
L -

8. Note that the address block and greeting line are surrounded by chevrons
(« »). Write a short letter and click Next: Preview your letters
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sAddressBlocks the d A
click ene of
aGreetinglinen

I really love your musicl

Dave —

Step 4 of 6

4 Previous: Select recipients

Preview your letter and click Next: Complete the merge.

Mail Merge ~ ~ X

Preview your letters

Mick Jagger Recipient: 1

Raolling Stones A2 Find a recipient.
Make changes

11 Elm 5., Sticky Fingers, TX You e

11111 re

Dear Mick, e th .
Exchude this recipien

I really love your music!

ished
rs, click

pave

Step 5 of §
€ Previous: Wi Mexdt wizard step
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Click Print to print your letters or Edit individual letters to further personalize
some or all of the letters.

Mail Merge * X

Lomplete the merge
Mail Merge is ready to

produce yaur letters

allze your letters

Step 6of 6
& P

33| Page




BCA-11IT www.sbs.ac.in

UNIT-II

SPREADSHEET

A spreadsheet or worksheet is a file made of rows and columns that help sort
data, arrange data easily, and calculate numerical data. What makes a
spreadsheet software program unique is its ability to calculate values using
mathematical formulas and the data in cells.

Spreadsheet overview

Below is a basic example of what a Microsoft Excel spreadsheet looks like, as well
as all the important features of a spreadsheet highlighted.
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Book1

-

g2 Insert ~

™ Delete ~

'_5"-2] Format ~
Cells

Currency
$ v % o

«.0 .00
.00 ».0

v v

&b Calibri 1
‘j Ba~| B Z U~ A X
Pafte J Sy - A =
Clipboard 1% Font

(&t
ol
4

Styles

v

S

\.? Il

Alignment I Number *

> or &
- sZrt& Find &

{a] L in L
27 Filter~ Select~

Editing

v fx | =SUM(D2:D5) Formula Bar

C D E F
Description Ammount

3/2015 Water bill $45.00
$67.00

$50.00

Column header

Selected Cell

Total: \ | 5162.00!

$523.00
$361.00

Check Balance:
Available:

Column and —»
Row Separators

Row Header

===

!

Column

|

<+— ROW —>

Sheet tabs

(14 <% M| Sheetl Sheet2 . Sheet3 /¥dJ M4 m

»[Iv

Ready | (3. | |[EO @ 100% )

) .

In the above example, this spreadsheet is listing three different checks, the date,

their description, and the value of each check. These values are then added
together to get the total of $162.00 in cell D6. That value is subtracted from the

check balance to give an available $361.00 in cell DS.

Examples and uses of a spreadsheet

Although spreadsheets are most often used with anything containing numbers,
the uses of a spreadsheet are almost endless. Below are some other popular uses

of spreadsheets.
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Finance

Spreadsheets are ideal for financial data, such as your checking account
information, budgets, taxes, transactions, billing, invoices, receipts, forecasts, and
any payment system.

Forms

Form templates can be created to handle inventory, evaluations, performance
reviews, quizzes, time sheets, patient information, and surveys.

School and grades

Teachers can use spreadsheets to track students, calculate grades, and identify
relevant data, such as high and low scores, missing tests, and students who are
struggling.

Lists

Managing a list in a spreadsheet is a great example of data that does not contain
numbers, but still can be used in a spreadsheet. Great examples of spreadsheet
lists include telephone, to-do, and grocery lists.

Sports

Spreadsheets can keep track of your favorite player stats or stats on the whole
team. With the collected data, you can also find averages, high scores, and
statistical data. Spreadsheets can even be used to create tournament brackets.

WORKBOOK
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In Microsoft Excel a workbook is a collection of one or more spreadsheets, also
called worksheets, in a single file. Below is an example of a spreadsheet called
"Sheetl" in an Excel workbook file called "Bookl." Our example also has the
"Sheet2" and "Sheet3" sheet tabs that are also part of the same workbook.

How to create a new workbook

To create a new workbook in Microsoft Excel, follow
the steps below for your version of Excel.

Microsoft Excel 2013 and later

1. Open Excel.
2. Click the File
3. Click New
4

. Under Featured, click Blank workbook.

Microsoft Excel 2010

1. Open Excel.

2. Click the File tab at the top of the window.
3. Click New

4. Click Blank workbook.

Microsoft Excel 2007

1. Open Excel.

2. Click the Office Button
37| Page
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3. Select Blank and recent.

4. In the right pane double-click Blank
workbook.

The Most Common Formatting Commands

There are many types of formatting that can be applied to Microsoft Excel
worksheets. The most commonly used formatting commands show up on
the Home tab in three groups:

1. The Font Group. The font group commands change the appearance of text
within a cell or of the cell itself.

2. The Alignment Group. The alignment group commands change the position
of text within a cell or cells.

3. The Number Group. The number group commands change the format of
numbers and dates within a cell.

Formatting changes can be applied to a whole worksheet, a range of cells within a

worksheet, individual cells, and sometimes even text within a cell.

Selecting Ranges of Cells

To select a range of cells in Microsoft Excel:

1. Click on a cell in one of the corners of the range of cells you wish to select
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B3 - Jx 3000

A B C D E F

3/31/2019 6/30/2019 9/30/2019 12/31/2019

Income

Lemonade | 3000_| 3100 3200 3300

Cookies 2000 2200 2400 2600

Total Income

Expense

Payroll

Marketing

Supplies

Total Expense

Net Income

LR e e
IS0V NO LA WN =

2.Hold the left mouse button down and drag horizontally and vertically until the
range you wish to select is highlighted:

9R x 4C v fx | 3000

A B C D E F
1 3/31/2019  6/30/2019  9/30/2019 12/31/2019
2 |Incomp
3 |Lemonade 3000 3100 3200 3300
4 |Cookies 2000 2200 2400 2600
5 |Total Income
6 |Expense
7 |Payroll
8 |Marketing
9 [Supplies
10 | Total Expense
11 [Net Income SEUBDIESRSEUEIS SUSSIS RN
12
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1. Release the click.

You can select all the cells in a row by clicking on the number to the left of the
row:

You can select all the cells in a column by clicking on the letter at the top of the
column:
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IO CASUS A
! |

Sl v o N v s W =

Adding Color to Worksheet Tabs

You can customize your workbook by applying colors to the sheet tabs. This can
help differentiate the tabs and make them stand out.

To add color to worksheet tabs:

1. Right-click the tab to which you want to add color.
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&2 View Code
11 Protect Sheet...

Tab Color té

Hide

Select All Sheets
1t1 | SheetZ | QD)

2. Select Tab Color

3. Select a color from the displayed options

Insert...
_x Delete
Rename

Move or Copy...

Vi Cod
Cﬁ Hewode Theme Colors

L1 Protect Sheet... H BEREER
Tab Color

L
Hide II
«ARNNESERS

Standard Colors

Select All Sheets Il EEEER
w1 | SheetZ | (4) No Color

% More Colors...
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Adding Themes to Workbooks

You can further customize workbooks and worksheets by using a Microsoft Office
theme. Themes apply a set of fonts, colors, and other effects.

To apply a theme to a worksheet:

1. On the Page Layout tab, in the Themes group, select Themes.

File Home Insert Draw Page Layout

Af| B coer 05 [ [ =

“hemes Margins Orientation Size Print Breaks Backgroun
- @ Effects - - - - Area - ©
Themes Page Setup

2. From the drop-down menu, select a theme to apply to the worksheet
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File

Home Insert

B colors - @ @

AlF

onts -

Draw

Page Layout

BRI

Themes Margins Orientation  Size Print
y %@ Effects - - - M Area -
Office -
: K%
Aa Aa Aa Aa B
EEEEER EEEEN ettt EEEEEE o
Office Facet Gallery Integral [
Aa Aa Aa— & |Aa ,
EETEEE EEEEEN EEEEN EEEEAE f
lon lon Board... Organic Retrospect i
A -» L
Aa Ad Aa Aa
EEEENE EEEEEN EEEEE L] ]
Slice Wisp Badge Banded
Aa Aa Aa Aa
mEETE nm mEn mEaEEN
Basis Berlin Circuit Crop
Aa Aa Aa Aa
EEEn EEEaEE [ | mm EEEEN.
Damask Dividend Droplet Feathered «

= Browse for Themes...

"—_|‘;| Save Current Theme...

=
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Bold, Italicize and Underline Text

To bold text in Microsoft Excel:

1. Select the cell or cells in which you wish to bold the text.
2. On the Home tab, in the Font group, click the Bold command.

File Home Insert Draw Page Layout Form
alln

Cut - - |

B 38 Arial 110 - A A N
Paste E Copy -

B) 7 U- - - A - =

- ¥ Format Painter U - a2 — .

Clipboard I Font =

To italicize text in Microsoft Excel:

1. Select the cell or cells in which you wish to italicize the text.
2. On the Home tab, in the Font group, click the Italic command.

File Home Insert Draw Page Layout Fo
aln
Cut = S
3{) Arial 110 - A A
Paste E Copy - B
JI "U - - - - A -
T ¥ Format Painter L\\} = — 2 —
Clipboard M Font s

To underline text in Microsoft Excel:

1. Select the cell or cells in which you wish to underline the text.
2. On the Home tab, in the Font group, click the Underline command.
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Home Insert Draw Page Layout Fo

-D.D _3{) cut Arial <10 - A A
Paste E Copy - P

7 ¥ Format Painter 1 \ QE\; T O - A -

Clipboard M Font” ™

Set Font and Font Size
To change the font of text or numbers in cells in Microsoft Excel:
1. Select the cell or cells in which you wish to change the font.

2. On the Home tab, in the Font group, click the arrow to the right of
the Font command.

File Home Insert Draw Page Layout Fori
ﬁ p =
Cut ‘ ) ) ]
3{) Calibri 10 - A A E
Paste E Copy - ”
B I U - . . A . g
N ¥ Format Painter = L =

Clipboard r~ Font P

3. Select a font from the drop down menu:
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I~ 1~

Calibri % =10
Theme Fonts

Cambria
Calibri
All Fonts

Abadi

Abadi Extra Light
Adobe Devanagari
Agency FB
Aharoni

Aldhabi

*LGERIAN
Andalus

Angsana New

AngsanaUPC
Aparajita

(Headings)
(Body)

To change the size of the font of text or numbers in cells in Microsoft Excel:

1. Select the cell or cells in which you wish to change the font size.
2. On the Home tab, in the Font group, click the arrow to the right of the Font

Size command. Select a font size from the drop down menu:
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Home Insert Draw Page Layout Fo
alla
Cut B - v
C?g Calibri - |10 N A A
Past "2 Copy 8
I U- D - A -
v ¥ Format Painter = 9 —
. 10
Clipboard F Fon 11 P

CELL REFERENCING

A cell reference refers to a cell or a range of cells on a worksheet and can be used
in a formula so that Microsoft Office Excel can find the values or data that you
want that formula to calculate.

In one or several formulas, you can use a cell reference to refer to:

Data from one or more contiguous cells on the worksheet.
Data contained in different areas of a worksheet.
Data on other worksheets in the same workbook.

For example:

This formula:

=C2

=Al1:F4

=Asset-Liability
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Refers to:
Cell C2

Cells Al through F4

The cells named
Asset and Liability

And Returns:
The value in cell C2.

The values in all cells, but you
must press Ctrl+Shift+Enter
after you type in your
formula.

The value in the cell named
Liability subtracted from the
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This formula:

{=Weekl+Week2}

=Sheet2!B2

Refers to: And Returns:

The cell ranges
named Week1 and

Wee

Cell B2 on Sheet2

k2

value in the cell named Asset.

The sum of the values of the
cell ranges named Week1 and
Week 2 as an array formula.

The value in cell B2 on Sheet?2.

Cell references in Excel are very important. Understand the difference between
relative, absolute and mixed reference, and you are on your way to success.

Relative Reference

By default, Excel uses relative references. See the formula in cell D2 below. Cell
D2 references (points to) cell B2 and cell C2. Both references are relative.

COUNTIF  ~ X K| =B2*C2
A B C D E F G H |
1 |Product lI:luzmtit',.r lPrice Amount
2 |bread I_ zl_ 1.5|=B2*C2
3 |butter 1 1.2
4 |cheese 3 2
5 |ham 3 1.8
o

1. Select cell D2, click on the lower right corner of cell D2 and drag it down to cell

DS5.
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COUNTIF - Fal v =B5*C5
A B C D E F G H 1

1 Product |I1uantity|Price Amount
2 |bread 2 15 3
3 |butter 1 1.2 1.2
4 |cheese 3 2 &

[ ] [ ]
5 [nam | 3| 1.8]=85*C5

| [ |
i

Cell D3 references cell B3 and cell C3. Cell D4 references cell B4 and cell C4. Cell
D5 references cell B5 and cell C5. In other words: each cell references its two
neighbors on the left.

Absolute Reference
See the formula in cell E3 below.

1. To create an absolute reference to cell H3, place a S symbol in front of the
column letter and row number (SHS3) in the formula of cell E3.

COUNTIF  ~ X « K | =B3*3HS3
A B C D E F G H |
1
2 .Length [cm]lWidth {cm) Length {inch) |Width {inch] .[nnverﬁinn rate
3 | | 1l 10 |=B2+3Hs3 | | _0.3937008 |
4 5 10
5 4 8
6 2 10
7

2. Now we can quickly drag this formula to the other cells.
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COUMTIF - < W 5 =CH*SHS3
A B C D E F G H |
1
2 Length (cm) |Width {cm) Length {inch) |Width {inch) .[nnverﬁinn rate
3 1 10 0.3937008 3.937008 l 0.3937008 .|
4 5 10 1.968504 3.937003
5 4. E. 1.5748032 3.1456064
6 | 2| 10] EI.?EMIIIlEl:CE*SHSB
7

The reference to cell H3 is fixed (when we drag the formula down and across). As
a result, the correct lengths and widths in inches are calculated.

Mixed Reference

Sometimes we need a combination of relative and absolute reference (mixed

reference).
1. See the formula in cell F2 below.

Feb Mar

COUNTIF  ~ X K =B2*(1-B6)
A B C D E F
1 |(Product lPrice ! Prices / Month (Jan
2 |Jeans l Elill Jeans =B2*(1-B6)
3 |Shirts | 30 Shirts
a4
5 |Month l.lan _Feb Mar
6 Heductiunl zu%l 40% 20%
7
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2. We want to copy this formula to the other cells quickly. Drag cell F2 across one
cell, and look at the formula in cell G2.

COUNTIF N P W J =C2*(1-C6)
il B C D E F ] H
1 |Product |Price ! I Prices [ Month |Jar1 Febh Mar
2 |leans snl_ _I Jeans 64|=C2*|:1-E|:|'] |
3 |Shirts 30 Shirts
4
5 |Month lan _Feb _Mar
6 Reduction 205*.5I_ 4DE:6_| 80%
7

Do you see what happens? The reference to the price should be a fixed reference
to column B. Solution: place a $ symbol in front of the column letter (SB2) in the
formula of cell F2. In a similar way, when we drag cell F2 down, the reference to
the reduction should be a fixed reference to row 6. Solution: place a S symbol in
front of the row number (BS6) in the formula of cell F2.

Result:
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COUNTIF - X v e =5B2%(1-BS0b)
A B C D E F G H
1 |Product |Price Prices / Month |Jan Feb Mar
2 |Jeans 1 BIZI_l Jeans |=852*t1—556]‘|
3 [Shirts 30 Shirts
a
5 Month Jan Feb Mar
6 |Reduction| 20%1 40% 80%
7

Note: we don't place a § symbol in front of the row number of SB2 (this way we
allow the reference to change from SB2 (Jeans) to $SB3 (Shirts) when we drag the
formula down). In a similar way, we don't place a S symbol in front of the column
letter of BS6 (this way we allow the reference to change from BS6 (Jan) to CS6
(Feb) and DS6 (Mar) when we drag the formula across).

3. Now we can quickly drag this formula to the other cells.

COUNTIF  ~ X « J | =%B3*1-D%6)
A B C D E F G H
1 |Product |Price Pricesannth|Jar1 Feb Mar
2 Jeans | 80 Jeans 64 48 16
3 |shirts | 30l Shirts 24 18|=$83*(1-D36)|
a4
5 Month |Jar1 Feb  Mar
6 Reduction| 20%  40%|  s0%]
7

The references to column B and row 6 are fixed.

CREATING FORMULAS IN EXCEL

Formulas and functions are the building blocks of working with numeric data in
Excel.
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What is a formula?

It is the simplest form, a formula is an expression made up of cell addresses and
arithmetic operators. Formulas can also be made up of discrete values i.e. =6*3.
Excel evaluates the formula to a value. An example of a formula looks as follows.

=A2*D2/2

HERE,

=" tells Excel that this is a formula, and it should evaluate it.

o "A2" * D2" makes reference to cell addresses A2 and D2 then multiplies the
values found in these cell addresses.

« "/"is the division arithmetic operator

o "2"is adiscrete value

Formulas practical exercise
We will work with the sample data for the home budget to calculate the subtotal.

o Create a new workbook in Excel
o Enter the data shown in the home supplies budget above.
e Your worksheet should look as follows.

A B C D E

Home supplies budget
5 FORMULA
3 15/N Item Qty Price GO Es HERE
4 | 1 Mangoes 9 B0 C 4*[] 4
5 2 Oranges 3 1200
o 3 Tomatoes 1 2300
7 4 Cooking Qil 5 6500
8 5 Tonic water 13 3900

We will now write the formula that calculates the subtotal

Set the focus to cell E4
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Enter the following formula.

=C4*D4

HERE,

"C4*D4" uses the arithmetic operator multiplication (*) to multiply the

value of the cell address C4 and DA4.

Press enter key

You will get the following result

E4

il

Formula
E

Home supplies budget

5/N

=] O oLn | e Ld A

oo

ltem Qty
1 Mangoes
2 Oranges
3 Tomatoes
4 Cooking Oil
5 Tonic water

Jx

-

L

=C4*D4
D E
Price btofal P Formula
— .

9 604 5400)) evaluation result
3 1200
1 2500
5 a500
13 3900

The following animated image shows you how to auto select cell address and
apply the same formula to other rows.
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H - = Formuals and Functions.xlsx - Excel T EH - O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Team 1 Rodrick K.. =
'“‘D % Calibri -l || == = % General 7 %Conditional Formatting = El %
Bz~ B I U- A a ===E- - 9% » [FromatasTable-
Paste 2| D S| A a o wf Formatas fable Cells  Editing
. W Hi. & A == - o o (7 Cell Styles~ . .

Clipboard & Font [F] Alignment . Number Styles -

E4 e 5 v
A B C D E F G H J K -

1 |Home supplies budget

2

3 |S/N Item Qty Price  Subtotal

4 |1 Mangoes 9 600 1

3 (2 QOranges 3 1200

6 |3 Tomatoes 1 2500

7|4 Cooking Oil 5 6500

8 |5 Tonic water 13 3300

g

10

12

13 -

» Functions sample data Worked exercise ... (¥ [] »
READY fH f -——+ 100

What is a function? (Function Wizard)

A function is a predefined formula. Functions allow you to use descriptive names
to automatically apply formulas for you. Examples of functions include;

e SUM for summation of a range of numbers
o AVERAGE for calculating the average of a given range of numbers
o COUNT for counting the number of items in a given range

The importance of functions

Functions increase user productivity when working with excel. Let's say you
would like to get the grand total for the above home supplies budget. To make it
simpler, you can use a formula to get the grand total. Using a formula, you would
have to reference the cells E4 through to E8 one by one. You would have to use
the following formula.

=E4+E5+E6+E7+E8
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With a function, you would write the above formula as
=SUM (E4:E8)

As you can see from the above function used to get the sum of a range of cells, it
is much more efficient to use a function to get the sum than using the formula
which will have to reference a lot of cells.

Common functions

Let's look at some of the most commonly used functions in Excel. We will start
with statistical functions.

S/ FUNCTION CATEGORY DESCRIPTION USAGE

N

01 SUM Math & Trig  Adds all the values in a range of cells =SUM(E4:E8)

02 MIN Statistical Finds the minimum value in arange of  =MIN(E4:E8)
cells

03 MAX Statistical Finds the maximum value in a range of =MAX(E4:E8)
cells
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04 AVERAGE  Statistical Calculates the average value in arange  =AVERAGE(E4
of cells :E8)

05 COUNT Statistical Counts the number of cells in a range =COUNT(E4:E
of cells 8)

06 LEN Text Returns the number of charactersin a =LEN(B7)
string text

07 SUMIF Math & Trig  Adds all the values in a range of cells =SUMIF(D4:D
that meet a specified criteria. 8,">=1000",C
=SUMIF(range,criteria,[sum_range]) 4:C8)

08 AVERAGEI Statistical Calculates the average value in arange  =AVERAGEIF(

F of cells that meet the specified criteria.  F4:F8,"Yes",E

=AVERAGEIF(range,criteria,[average_ra 4:E8)
nge])

09 DAYS Date & Time Returns the number of days between =DAYS(D4,C4)
two dates

10 NOW Date & Time Returns the current system date and =NOW()

Numeric Functions

time

As the name suggests, these functions operate on numeric data. The following
table shows some of the common numeric functions.
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S/N FUNCTION

1 ISNUMBER

2 RAND

3 ROUND
4 MEDIAN
5 P

6 POWER
7 MOD
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CATEGORY

Information

Math &
Trig

Math &
Trig

Statistical

Math &
Trig

Math &
Trig

Math &
Trig

DESCRIPTION

Returns True if the supplied
value is numeric and False if
it is not numeric

Generates a random number
betweenOand 1

Rounds off a decimal value to
the specified number of
decimal points

Returns the number in the
middle of the set of given
numbers

Returns the value of Math
Function PI(rm)

Returns the result of a
number raised to a
power. POWER( number,
power )

Returns the Remainder when
you divide two numbers

USAGE

=ISNUMBER(A3)

=RAND()

=ROUND(3.14455,2)

=MEDIAN(3,4,5,2,5)

=PI)

=POWER(2,4)

=MOD(10,3)
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8 ROMAN Math & Converts a number to roman =ROMAN(1984)
Trig numerals

String functions

These functions are used to manipulate text data. The following table shows some
of the common string functions.

S/ FUNCTION CATEGORY DESCRIPTION USAGE COMME
N NT
1 LEFT Text Returns a number of =LEFT("GURU99", Left4
specified characters 4) Characte
from the start (left-hand rs of
side) of a string "GURU9
g
2  RIGHT Text Returns a number of =RIGHT("GURU9 Right 2
specified characters 9",2) Characte
from the end (right-hand rs of
side) of a string "GURU9
g
3 MID Text Retrieves a number of =MID("GURU99", Retrievi
characters from the 2,3) ng
middle of a string from a Characte
specified start position rs2to5

and length. =MID (text,
start_num, num_chars)
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4 ISTEXT Information  Returns True if the =|STEXT(value) value -
supplied parameter is The
Text value to

check.

5 FIND Text Returns the starting =FIND("00","Roof Find oo
position of a text string ing",1) in
within another text "Roofing
string. This function is " Result
case- is 2
sensitive. =FIND(find_te
xt, within_text,

[start_num])

6 REPLACE Text Replaces part of a string  =REPLACE("Roofi Replace
with another specified ng",2,2,"xx" "00"
string. =REPLACE with
(old_text, start_num, "xx"
num_chars, new_text)

Date Time Functions

These functions are used to manipulate date values. The following table shows

some of the common date functions

S/ FUNCTION CATEGORY DESCRIPTION USAGE

N
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1 DATE Date & Time  Returns the number that =DATE(2015,
represents the date in excel code 2,4)

2 DAYS Date & Time  Find the number of days between =DAYS(D6,C6)
two dates

3 MONTH Date & Time Returns the month from a date =MONTH("4/
value 2/2015")

4 MINUTE Date & Time  Returns the minutes from atime  =MINUTE("12
value :31")

5 YEAR Date & Time  Returns the year from a date =YEAR("04/0
value 2/2015")

GRAPHS AND CHARTS IN EXCEL

Charts and graphs elevate your data by providing an easy-to-understand
visualization of numeric values. While the terms are often used interchangeably,
they are slightly different. Graphs are the most basic way to represent data
visually, and typically display data point values over a duration of time. Charts are
a bit more complex, as they allow you to compare pieces of a data set relative to
the other data in that set. Charts are also considered more visual than graphs,
since they often take a different shape than a generic x- and y-axis.

People often use charts and graphs in presentations to give management, client,
or team members a quick snapshot into progress or results. You can create a
chart or graph to represent nearly any kind of quantitative data — doing so will
save you the time and frustration of poring through spreadsheets to find
relationships and trends.
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It’s easy to create charts and graphs in Excel, especially since you can also store
your data directly in an Excel Workbook, rather than importing data from another
program. Excel also has a variety of preset chart and graph types so you can select
one that best represents the data relationship(s) you want to highlight.

How to Chart Data in Excel

To generate a chart or graph in Excel, you must first provide Excel with data to
pull from. In this section, we’ll show you how to chart data in Excel 2016.

Step 1: Enter Data into a Worksheet

1. Open Excel and select New Workbook.

2. Enter the data you want to use to create a graph or chart. In this example,
we’re comparing the profit of five different products from 2013 to 2017. Be
sure to include labels for your columns and rows. Doing so enables you to
translate the data into a chart or graph with clear axis labels. You can

download this sample data below.

A B c D E F
1|E:IEIvE:EI||v 0! M 2015 Kd2o1s Ed2017 K3
2 ProductA 18,580  $49,225 516,326 510,017  $26,134
3 | Product B 478,570  $82,262  S$48,640 548,640  $48,640
4 Product € $24,236  $131,330 579,022  5$7L,009  $81,474
5 Product D $16,730  $19,730  $12,109  $11,355  $17,686
& ProductE 35,358  $42,685  $20,893 516065  $21,388
7

Step 2: Select Range to Create Chart or Graph from Workbook Data

1. Highlight the cells that contain the data you want to use in your graph by

clicking and dragging your mouse across the cells.

2. Your cell range will now be highlighted in gray and you can select a chart

type.
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Home Insert Page Layout Formulas Data Review  View

o _
- & out Calibri(Body) ~ 12 + A~ Av = = _ &~
1 Copy ~ 8
Past v v + A - = = = &= &=
®* & Format LA — — == | ===
G6 = fx

8 [Product Bd 2013 B 2014 B 2015 B4 2016 R4 2017 B4
2 |Product A 518,580 549,225 516,326 510,017 526,134
3 |Product B $78,970  $82,262  S48,640  S$48,640 548,640
4 |Product € 524,236  $131,390 579,022  $71,009 581,474
5 |Product D $16,730 515,730 512,108 511,355 517,686
6 |Product E 435358  $42,685 520,893  S16,065 521,388

How to Make a Chart in Excel

Once you input your data and select the cell range, you’re ready to choose your
chart type to display your data. In this example, we’ll create a clustered column
chart from the data we used in the previous section.

Step 1: Select Chart Type

Once your data is highlighted in the Workbook, click the Insert tab on the top
banner. About halfway across the toolbar is a section with several chart options.
Excel provides Recommended Charts based on popularity, but you can click any of
the dropdown menus to select a different template.

Home Insert Page Layout Formulas Data Review View

£y T ' [u [ ]
v ! v v o Store P v - (-
g iz ) By g @ B o w=
PivotTakble Recommended Tahle Pictures Shapes SmartArt Screenshot a My Add-ins ~ Bing Peopla Recommended pi~v |‘_" r B~
PivotTables Maps Graph Charts ! e

Step 2: Create Your Chart

64| Page




BCA-11IT www.sbs.ac.in

1. From the Insert tab, click the column chart icon and select Clustered
Column.

Clusterad Column Stacked Column 100% Stacked Column

3-0 Column

1. Excel will automatically create a clustered chart column from your selected
data. The chart will appear in the center of your workbook.

2. To name your chart, double click the Chart Title text in the chart and type a
title. We'll call this chart “Product Profit 2013 - 2017.”

[Product Profit 2013 - 2017
140000
120000
100000

B0000
60000
40000 I
20000
| | ] I
0
2013 20314 2015 2018 2017
W praduct Product B MProduct C ¥ Produe tD Product E

We’'ll use this chart for the rest of the walkthrough. You can download this same
chart to follow along.
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COLUMN CHART TEMPLATE
reopuct [l 203 Gl 2004 B 205 B a6 B 207 B

Frocuct A $18.580 $49.225 $16,326 $10,017 $26,134
Proguct 3 . $7897C ‘ $82.242 S48 640 S48 640 $48 640
Procuct C $24236 $131.3%¢ 79022 $71.009 381 474
PFrocuct D $16,730 $19.730 $12.109 $11,355 ' $17.686
froauct & 535358 $42.485 s20893  sleoes 21388

PRODUCT OVERVIEW
140000

120000
100000

80000

40000

40000

20000 I I
I i Rl 1

2013 2014 2015 2016 2017

mProduct A ®Productd ®Product C  ®Product D Product £

There are two tabs on the toolbar that you will use to make adjustments to your
chart: Chart Design and Format. Excel automatically applies design, layout, and
format presets to charts and graphs, but you can add customization by exploring
the tabs. Next, we’ll walk you through all the available adjustments in Chart
Design.

Home Insert Pagelayout Formulas Data Review View [EMELQEEN
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Step 3: Add Chart Elements

Adding chart elements to your chart or graph will enhance it by clarifying data or
providing additional context. You can select a chart element by clicking on

the Add Chart Element dropdown menu in the top left-hand corner (beneath

the Home tab).

LT

BR| ™ o

°®

b Axes

b Axis Titles
b Chart Title
I Data Labels
I Data Table
b Error Bars
i

Gridlines

¥y ¥y ¥y vy y vy vyy

I Legend

1 | Trendline 3
1

1

How to Make a Graph in Excel

Although graphs and charts are distinct, Excel groups all graphs under the charts
categories listed in the previous sections. To create a graph or another chart type,
follow the steps below and select the appropriate graph type.

Select Range to Create a Graph from Workbook Data

1. Highlight the cells that contain the data you want to use in your graph by
clicking and dragging your mouse across the cells.
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2. Your cell range will now be highlighted in gray.

Home Insert Page Layout Formulas Data Review  View

el —
- & out Calibri(Body) ~ 12 + A~ Av = = _ &~
1 Copy ~ 8
Past v v + A« = = = = ®=
aste %' Format B I = — _— - - =|"E =
G6 = fx

8 [Product Bd 2013 B 2014 B 2015 B4 2016 R4 2017 B4
2 |Product A 518,580 549,225 516,326 510,017 526,134
3 |Product B $78,970  $82,262  S48,640  S$48,640 548,640
4 |Product € 524,236  $131,390 579,022  $71,009 581,474
5 |Product D $16,730 515,730 512,108 511,355 517,686
6 |Product E 435358  $42,685 520,893  S16,065 521,388

3. Once the text is highlighted you can select a graph (which Excel refers to as
chart). Click the Insert tab and click Recommended Charts on the toolbar.
Then click the type of graph you wish to use.

Home Insert Page Layout Formulas Data Review View

id [z aa] [ - (g W sen B

PivotTable Recommended Table Pictures Shapes SmartArt Screenshot a My Add-ins *+ Bing People Recommendead

PivotTables Maps Graph
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.-

Re

Now you have a graph. To customize your graph, you can follow the same steps
explained in the previous section. All functionality for creating a chart remains the
same when creating a graph.

How to Create a Table in Excel

If you don’t need to make a data visualization, you can also create a table in Excel
using preexisting data. There are two ways to format a data set as a table:

o Manually: In this example, we manually added data and formatted as a
table by including column and row names (products and years).

« Use Excel’s Format as Table Preset: You can also input raw data (numbers
without any column and row names).

1. To format data as a table, click and drag your mouse across the cells with
the data range, click the Home tab, and click the Format as Table drop-

i
Format

down menu on the toolbar. as Table
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2. Click New Table Style... (You will also see an option to use PivotTables. This
feature is outside the scope of this how-to, but the concept is explained in
the following

Sustom

Light

Medium

New Table Style...
3. section). | New PivotTable Style...
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4. A dialogue box opens and you can choose which aspects of the selected

range to include in your formatted table. Click the blue OK button.
[ Mew Table Style

Name: | [iableiSiyied

Table element Preview

Whole Table

First Column Stripe
Second Column Stripe
First Row Stripe
Second Row Stripe
Last Column

First Column

PEEEEEE
PFEEEEEE
P83 OEEE¥
I A A
PR OEEEE
PEOEOEEEE

Format

Set as default table style for this workbook

Cancel | (TSN
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PRESENTATION GRAPHICS SOFTWARE

Presentation graphics software are tools that let people make slideshows of
charts, diagrams and graphics on the computer that can be show to a group
using a projector.

An example of presentation graphics software is Microsoft PowerPoint.

Presentation software (sometimes called "presentation graphics") is a
category of application program used to create sequences of words and
pictures that tell a story or help support a speech or public presentation of
information. Presentation software can be divided into business presentation
software and more general multimedia authoring tools, with some products
having characteristics of both. Business presentation software emphasizes
ease- and quickness-of-learning and use. Multimedia authoring software
enables you to create a more sophisticated presentation that includes audio
and video sequences. Business presentation software usually enables you to
include images and sometimes audio and video developed with other tools.

Microsoft PowerPoint

Microsoft PowerPoint is a powerful presentation software developed by
Microsoft. It is a standard component of the company's Microsoft Office suite
software, and is bundled together with Word, Excel and other Office productivity
tools. The program uses slides to convey information rich in multimedia. The term
"slide" refers to the slide projector, which this software effectively replaces.

Features of MS PowerPoint

PowerPoint is a complete presentation Graphics package. It gives everything that
we need to produce a professional-looking presentation. PowerPoint offers word
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processing software, outlining, drawing, graphing, and presentation management
tools- all designed to be easy to use and learn.

Below are the various Features avalaible for MS Powerpoint

1) Adding Smart Art

Click to add title

* Click to add text

Don’t confuse SmartArt with the similarly named WordArt. Where WordArt just
allows you to display text using a wide variety of different formats and effects,
SmartArt is a comprehensive and flexible business diagram tool that greatly
improves upon the ‘Diagram Gallery’ feature found in previous versions of Office.

Click the insert SmartChart Graphic to choose from a selection of options.

2) Inserting Shapes
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If you need to include some sort of diagram in your presentation, then the
quickest and easiest way is probably to use SmartArt. However, it is important to
be able to include shapes independently of SmartArt and worth being familiar
with the various Drawing Tool format options.

Not only will they be useful if you do need to manually draw a diagram (and
SmartArt doesn’t suit all diagrams), but they can also be applied to objects on a
slide that you might not immediately think of as shapes. For example the box that
contains your slide title or your content. This can be anything from text to a video,
or even the individual shapes in a SmartArt diagram.

As you can see, the gallery of available shapes is very extensive. Once you have
selected your chosen shape, you can just click in your slide to insert a default
version of the shape or, to set a particular size and position, click and drag with
the mouse to create the shape and size you want.

3) Inserting an Image
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Here are two content type icons which appear in new content Placeholders for
inserting pictures. You can Insert Picture from File or Insert Clip Art. Alternatively,
the lllustrations group of the Insert ribbon tab includes the same two tools. In
addition, PowerPoint 2010 has a new ‘Screenshot’ option that allows you to
capture an entire window or part of a window for inclusion on a slide. You can
also copy any image and just paste it directly to a slide.

Insert Picture from File allows you to browse to an image file saved somewhere
on your system whereas Clip Art is held in an indexed gallery of different media
types. Clip Art is not limited to pictures: ‘The Results should be:” box lets you
choose between: ‘All media file types’ and one or more of the following different
types:

o lllustrations

o Photographs

o Video

o Audio
Once you have found the image you want to use, click on it to insert it into the
current slide. You can now re-size and move the image accordingly with further
editting options available when you right click the desired image.
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4) Slide Transitions
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Properly used, slide transitions can be make your presentations clearer and more
interesting and, where appropriate, more fun. Badly used, the effect of slide
transitions can be closer to irritating or even nauseating. Simple animation effects
are often used to add interest to bullet point text. Much more extreme animation
effects are available but, in most cases, should be used sparingly if at all.

Two main kinds of animation are available in a PowerPoint presentation: the
transition from one slide to the next and the animation of images/text on a
specific slide.

In PowerPoint 2010 & 2013 there is also a separate Transitions ribbon tab that
includes a gallery of different transition effects. These can be applied to selected
slides or all slides. If you want to apply different transition effects to different
groups of slides, then you might want to choose ‘Slide Sorter’ view from the
Presentation Views group of the View ribbon.
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5) Adding Animations
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Whereas the transition effects are limited to a single event per slide, animations
can be applied to every object on a slide — including titles and other text boxes.
Many objects can even have animation applied to different components, for
example each shape in a SmartArt graphic, each paragraph in a text box and each
column in a chart. Animations can be applied to three separate ‘events’ for each

object:

Entrance — how the object arrives on the slide

Emphasis — an effect to focus attention on an object while it is visible

Exit — how the object disappears from the slide

To apply an animation effect, choose the object or objects to be animated, then
choose Animation Styles or Add Animation from the Animations toolbar.

Where an animation is applied to an object with different components (for
instance a SmartArt graphic made up of several boxes), the Effect Options tool
becomes available to control how each component will be animated. So for
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example, your animation can be used to introduce elements of an organisation
chart to your slide one by one.

Templates

A PowerPoint design template is a pre-made design you can use to lend
cohesiveness, visual organization and appeal to your presentation. All you have to
do is add your own content; the rest is already designed into the template. Even
though individual slides can have different layouts and graphics, templates help
the whole presentation go together as an attractive package.

Powerpoint: Formatting a Slide
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To Select Text in a Text Box:
1) Position your cursor inside the text box by clicking once
2) Click and drag your mouse to select the desired text

To Select a Word:
Double click your mouse on the word

To Select an Entire Text Box:
Click once on the text box
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Formatting Text
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To Bold Text on a Slide:
1) Select the text

2) Click the Bold Icon on the Formatting Toolbar

To Italicize Text on a Slide:
1) Select the text

2) Click the Italic Icon on the Formatting Toolbar

To Underline Text on a Slide
1) Select the text

2) Click the Underline Icon on the Formatting Toolbar

To Select a Different Font
1) Select the text

2) Click the drop down arrow for Font on the Formatting Toolbar and
select a font

To Select a Different Font Size
1) Select the text

lettering)

different font size (The larger the number the larger the

2) Click the Font Size Icon on the Formatting Toolbar and pick a
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To Change the Font Color
1) Select the text
2) Click the Font Color drop down arrow on the Formatting
Toolbarand select a different font color

Selecting a Slide Design

Microsoft PowerPoint provides design templates that you can
apply to a presentation to give it a fully designed, professional
look.

To Select a Design for your Presentation:
1) Click the Design Button on your Formatting Toolbar
2) From the Task Pane on the right, click on the desired design

Note: The design, by default, is applied to all pages of the presentation.

Use charts and graphs in your presentation

You can make a chart in PowerPoint or Excel. If you have lots of data to

chart, create your chart in Excel, and then copy it into your presentation. This is
also the best way if your data changes regularly and you want your chart to
always reflect the latest numbers. In that case, when you copy and paste the
chart, keep it linked to the original Excel file.

To create a simple chart from scratch in PowerPoint, click Insert > Chart and pick
the chart you want.

. Click Insert > Chart.
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2. Click the chart type and then double-click the chart you want.
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3. In the worksheet that appears, replace the placeholder data with your own
information.
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4. When you’ve finished, close the worksheet.

The Different Types of Animations In PowerPoint

Animations are visual effects which make your texts, images, shapes, or charts
come ‘alive.” They catch your audience’s attention and helps them engage with
you and your presentation.

Moreover, there are generally two types of animations you can use to make your
presentation come alive. These are:

« Transitions
The first type of animation is called transition animation; these are animations
added in between slides. When you transition from slide 1 to slide 2, you can add
an animation in between the slides. You can view the different transition options
by going to the Transitions pane on the PowerPoint ribbon.
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The default view shows 10 transitions, but if you click on the little arrow like you

see in the screenshot above, then you’ll see many more options like you see here:

_ TRANSITIONS
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MNone Cut Fade Push Wipe Split Reveal Random Bars Shape Uncover
Cover Flash
Exciting
Fall Over Drape Curtain Wind Prestige Fracture Crush Peel Off Page Curl Airplane
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= O O =
Switch Flip Gallery Cube Doors Box Comb Zoom Random
Dynamic Content
i
Pan Ferris Wheel Conveyor Rotate Window Orbit Fly Through

Transition animations have additional effect options. You will notice this when
you click on the transition you want to use. The Effect Options button won’t be
grayed out, and you can select additional settings.

For example, | selected ‘Reveal’ as my transition animation. Available effect

options would be:
« Smoothly from right
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e Smoothly from left
e Through black from right

« Through black from left

Here’s a screenshot of what it looks like:

“ TRAMSITIONS

I [

| - ol 4 & I A

Effect
Options

Transition to This Slide
I Smoothly From Right

. Smoothly From Left
| Through Black From Right

- Through Black From Left

Reveal

You can also adjust the timing and duration of each transition as well as set how

you want the slides to advance so that the transition can take place.
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Adjust these settings
as you see fit.

Feel free to play around with the transition animations and effect options that
work best with your presentation.
« Animations

The second type of animations brings the objects or elements within your slide to
life. If you want to animate text, an image, shape, graph or chart, this is the type

of animation you select.
You first to have to click on the object you want to animate, then click on the

Animations tab.

_ | ANIMATIONS |
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Naone Appear Fade Fly In Flaat In Split Wipe Shape = C,E
"
Animation
. Click for more

Animation options
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The default view shows 8 animations, but if you click on the little arrow like you

see on the screenshot above, then you’ll see many more options like you see

here:
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You can choose from the following types of animations:
« Entrance animations. The icons for this type of animation are colored green.

If you use this type of animation for an object, that object will enter the
slide according to your timing preferences.

« Exit animations. The icons for this type of animation are colored red. The
object you’ve added this animation to will exit the slide.

« Emphasis animations. The icons for this kind of animation are colored
yellow. The object won’t enter or exit the slide (unless you’ve added that
particular animation to the same object) but will emphasize and draw
attention to that object.

« Motion path animations. This type of animation will allow you to move an
object from one spot to another. You can specify or draw the path you want
the object to take.

In the next sections, we’ll go over how to add the 4 different types of

animations to your slides.
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How To Add Animations to PowerPoint In 2 Simple Steps

To add entrance animations to any object in PowerPoint, here’s what you need to

do:
1. Click on the object you want to animate. In this example, we will use a blue

smiley face.

2. Select the animation you want to use. For this example, we used
the entrance animation — fade animation. We set the duration to 2.75 seconds.
You will notice in the screenshot below that the fade animation has no effect
options (the button is greyed out).

ANIMATIONS

P Start: |On Click - | Reorder Animation|
© Duration: 0275 Move Earlier
#5 Animation Painter  (®) Delay: 0000 Move Later

Animation Pane ¥ %

b Play From

14 Smiley Face 4 -
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Here’s what those numbers in the screenshot mean:
1 - We chose the Fade animation.

2 —There are no Effect Options for Fade Animation (the button is grayed out and
not clickable)

3 —You can adjust settings via the Advanced Animation, Timing, and Animation
Pane sections

4 —The number (1) refers to the fact that we’ve added 1 animation to our object
(this is the Fade animation).

5—You can click on the Preview button to preview the animation.

As you can see, adding animations to an object is no rocket science. You can even
add entrance, exit, emphasis and motion path animations to a single object!

Important Points To Remember When Adding Animations

It’s so easy adding animations to presentation slides that you can easily lose
control. Therefore, you'll find yourself animating all objects on your slides and
adding slide transitions as well. Nevertheless, it might look fun to you, but in
reality, it can distract your audience’s attention from the message you’re trying to
convey in your presentation.
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So here are some guidelines you should following when adding animations to

PowerPoint:

1. Simplicity is key. Simple animations like fade and appear may not be as
impressive as other animations available, but these add a touch of elegance
to well-timed slides. It makes your slides look clean and simple.

2. Limit the number of animations on a slide. One or two animations per slide
should suffice. There’s really no need to animate every single object on each
slide.

3. Time your presentation well. Make sure your objects appear right after you
introduce it. This keeps your audience’s interest piqued.

4. Don’t forget to practice. Practicing your timings and your animations are key
to a successful presentation.

POWERPOINT SLIDESHOW

A PowerPoint slideshow (PPT) is a presentation created on software from
Microsoft that allows users to add audio, visual and audio/visual features to a
presentation. It is considered to be a multimedia technology and also acts as a
tool for collaboration and content sharing. PowerPoint is included in Microsoft
Office, making it one of the most well-known and widely used brands of
presentation software.

A PowerPoint slideshow is also known as a PowerPoint presentation

Slide Show view is the view that you use when showing the presentation to
others. One slide appears onscreen at a time, completely filling the screen. You
may have used this view already — to check your work — while you were creating
the presentation.

You can start Slide Show view from the first slide or from the current slide. The
following table summarizes the methods of doing each.
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Methods of Entering Slide

Show View

From First Slide From Current Slide

Shortcut key(s) Press F5 Press Shift+F5

View tab Slide Show—>From Slide Show—>From
Beginning Current Slide

View buttons (bottom N/A Slide Show View button

right of screen)

Then, after you’re in Slide Show view, you can show your presentation. Here’s
how:

« Move to the next slide (in any of these ways):
o Click the mouse.
o Press any key on the keyboard (except Backspace or the left arrow).
o Right-click to display a shortcut menu and then choose Next.
« Move to the previous slide (in any of these ways):
o Press Backspace or the left arrow on the keyboard.
o Right-click to display a shortcut menu and choose Previous.
« Jump to a specific slide:
o a.Right-click to display a shortcut menu.
o b.Point to Go to Slide.

o c.Click the slide you want to display.
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o End the show (in any of these ways):

o Click through to the end of the slide show (black screen) and then
click one more time.

o Press the Esc key.

o Right-click to display a shortcut menu and then choose End Show.

UNIT-D
e Secure Electronic Transaction,

e Types ofPayment System: Digital Cash, Electronic Cheque, Smart Card,
Credit/Debit

e Card E-Money, Bit Coins and Crypto currency, Electronic Fund Transfer

e (EFT), Unified Payment Interface (UPI), Immediate Payment System (IMPS),

e Digital Signature and Certification Authority.

e Introduction to Bluetooth, Cloud Computing, Big Data, Data Mining, Mobile

e Computing and Embedded Systems and Internet of Things (loT)

Electronic Payment System

Electronic Payment is a financial exchange that takes place online between buyers
and sellers. The content of this exchange is usually some form of digital financial
instrument (such as encrypted credit card numbers, electronic cheques or digital
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cash) that is backed by a bank or an intermediary, or by a legal tender. The
various factors that have lead the financial institutions to make use of electronic
payments are:

1. Decreasing technology cost:

The technology used in the networks is decreasing day by day, which is
evident from the fact that computers are now dirt-cheap and Internet is
becoming free almost everywhere in the world.

2. Reduced operational and processing cost:

Due to reduced technology cost the processing cost of various commerce
activities becomes very less. A very simple reason to prove this is the fact
that in electronic transactions we save both paper and time.

3. Increasing online commerce:

Secure Electronic Transactions

Secure Electronic Transaction or SET is a system which ensures security and
integrity of electronic transactions done using credit cards in a scenario. SET is not
some system that enables payment but it is a security protocol applied on those
payments. It uses different encryption and hashing techniques to secure
payments over internet done through credit cards. SET protocol was supported in
development by major organizations like Visa, Mastercard, Microsoft which
provided its Secure Transaction Technology (STT) and NetScape which provided
technology of Secure Socket Layer (SSL).

SET protocol restricts revealing of credit card details to merchants thus keeping
hackers and thieves at bay. SET protocol includes Certification Authorities for
making use of standard Digital Certificates like X.509 Certificate.

Before discussing SET further, let’s see a general scenario of electronic
transaction, which includes client, payment gateway, client financial institution,
merchant and merchant financial institution.
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Requirements in SET :
SET protocol has some requirements to meet, some of the important
requirements are :

It has to provide mutual authentication i.e., customer (or cardholder)
authentication by confirming if the customer is intended user or not and
merchant authentication.

It has to keep the Pl (Payment Information) and Ol (Order Information)
confidential by appropriate encryptions.

It has to be resistive against message modifications i.e., no changes should be
allowed in the content being transmitted.

SET also needs to provide interoperability and make use of best security
mechanisms.

Participants in SET :
In the general scenario of online transaction, SET includes similar participants:

1.

vk wnN

Cardholder — customer

Issuer — customer financial institution(bank )

Merchant

Acquirer — Merchant financial

Certificate authority — Authority which follows certain standards and issues
certificates(like X.509V3) to all other participants.
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Types of Electronic Payment System

When you purchase goods and services online, you pay for them using an
electronic medium. This mode of payment, without using cash or cheque, is called
an e-commerce payment system and is also known as online or electronic
payment systems.

The growing use of internet-based banking and shopping has seen the growth of
various e-commerce payment systems and technology has been developed to
increase, improve and provide secure e-payment transactions.

Paperless e-commerce payments have revolutionised the payment processing by
reducing paper work, transaction costs, and personnel cost. The systems are user-
friendly and consume less time than manual processing and help businesses
extend their market reach.

The different types of e-commerce payments in use today are:

1. Digital Cash

Digital Cash acts much like real cash, except that it’s not on paper. Money in your
bank account is converted to a digital code. This digital code may then be stored
on a microchip, a pocket card (like a smart card), or on the hard drive of your
computer.

Bank ¢ Merchant

3.
terchant checks with
Bank to ensure that
the Digital Cash is
walidd,

2.
Consumer contacts
merchant, offers
Digital Cash

for goods.

4
Merchant accepts
Digital Cash and
delivers product.

1.
Consumer gives
bank maney. gets
Digital Cash.

In zome syztems,

citizenz can hansfer
Digital Cash among
themzelves.
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The concept of privacy is the driving force behind digital cash. The user of
digital cash is assured an anonymous transaction by any vendor who accepts
it. Your special bank account code can be used over the internet or at any
participating merchant to purchase an item. Everybody involved in the
transaction, from the bank to the user to the vendor, agree to recognize the
worth of the transaction, and thus create this new form or exchange.

Bank

Issue of k for
Digital Payment
Cash g

Person A (Sjem)il Digital Person B

2

This example shows how digital cash might work through a banking
institution. The bank creates a digital bank note by signing a message which
specifies the serial number (with a primary or public key) and value of the note,
and sends it to Person A. Person A, as he withdraws it, uses Chaum's technique (A
Cryptography technique) to alter the serial number so that the bank will not
recognize the note as being from this withdrawal. This note is now returned to
the bank with the new serial number. The bank now has a note with a new serial
number. Person A then pays Person B electronically by sending the bank note to
him. Person B checks the note's validity by decrypting using the bank's public key
to check its signature (new serial number validity). Person B then sends the note
to the bank, which checks the serial number to confirm that this bank note hasn't
been spent before. The serial number is now different from that in Person A’s
withdrawal, thereby pre- venting the bank from linking the two transactions. The
enabling bank merely checks the new serialized key account for the amount of the
transaction and transfers the money by sending out a depository notice. Person B
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using the same encrypting technique returns the depository notice with the new
serialize account.

2. Electronic Cheque:

An electronic check or e check is a form of payment made via the Internet, or
another data network, designed to perform the same function as a conventional
paper check. Since the check is in an electronic format, it can be processed in
fewer steps.

Additionally, it has more security features than standard paper checks including
authentication, public key cryptography, digital signatures, and encryption,
among others.

o An electronic check is a form of payment made via the internet that is
designed to perform the same function as a conventional paper check.

« One of the more frequently used versions of the electronic check is the
direct deposit system offered by many employers.

« Generally, the costs associated with issuing an electronic check are notably
lower than those associated with paper checks.

« An electronic check has more security features than standard paper checks.

How an Electronic Check Works

An electronic check is part of the larger electronic banking field and part of a
subset of transactions referred to as electronic fund transfers (EFTs). This includes
not only electronic checks but also other computerized banking functions such as
ATM withdrawals and deposits, debit card transactions and remote check
depositing features. The transactions require the use of various computer and
networking technologies to gain access to the relevant account data to perform
the requested actions.
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How Digital Checking Works: eCheck
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3. Smart Card

Smart Card It is a plastic card embedded with a microprocessor that has the
customer’s personal information stored in it and can be loaded with funds to
make online transactions and instant payment of bills. The money that is loaded
in the smart card reduces as per the usage by the customer and has to be
reloaded from his/her bank account.

A smart card is a physical card that has an embedded integrated chip that acts as
a security token. Smart cards are typically the same size as a driver's license or
credit card and can be made out of metal or plastic. They connect to a reader
either by direct physical contact (also known as chip and dip) or through a short-
range wireless connectivity standard such as radio-frequency identification
(RFID).The chip on a smart card can be either a microcontroller or an embedded
memory chip. Smart cards are designed to be tamper-resistant and use
encryption to provide protection for in-memory information. Those cards with
microcontroller chips can perform on-card processing functions and can
manipulate information in the chip's memory.
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Smart cards are used for a variety of applications, though most commonly are
used for credit cards and other payment cards
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How smart cards work

Smart card microprocessors or memory chips exchange data with card readers
and other systems over a serial interface. The smart card itself is powered by an
external source, usually the smart card reader. A smart card communicates with
readers either via direct physical contact or using a short-range wireless
connectivity standard such as RFID . The card reader then passes data from the
smart card to its intended destination, usually a payment or authentication
system connected to the smart card reader over a network connection.

3. Credit Card

Credit Card The most popular form of payment for e-commerce transactions is
through credit cards. It is simple to use; the customer has to just enter their credit
card number and date of expiry in the appropriate area on the seller’s web page.
To improve the security system, increased security measures, such as the use of a
card verification number (CVN), have been introduced to on-line credit card
payments. The CVN system helps detect fraud by comparing the CVN number
with the cardholder's information.

Users can swipe the credit card to make a payment or use it for online
transactions. After you apply for a credit card, simply make sure that the
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borrowed amount is repaid within the stipulated time frame to avoid penalty
charges. Your credit card details are always secured with the card issuer and you
should not share your credit card information with anyone to avoid fraud.

The credit company provider may also grant a line of credit (LOC) to cardholders,
enabling them to borrow money in the form of cash advances. Issuers customarily
pre-set borrowing limits, based on an individual's credit rating. A vast majority of
businesses let the customer make purchases with credit cards, which remain one
of today's most popular payment methodologies for buying consumer goods and
services.
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4. Debit Card

Debit Card Debit cards are the second largest e-commerce payment medium in
India. Customers who want to spend online within their financial limits prefer to
pay with their Debit cards. With the debit card, the customer can only pay for
purchased goods with the money that is already there in his/her bank account as
opposed to the credit card where the amounts that the buyer spends are billed to
him/her and payments are made at the end of the billing period.

A debit card is a payment card that deducts money directly from a
consumer’s checking account to pay for a purchase. Debit cards eliminate the
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need to carry cash or physical checks to make purchases. In addition, debit cards,
also called check cards, offer the convenience of credit cards and many of the
same consumer protections when issued by major payment processors like Visa
or Mastercard.

Unlike credit cards, debit cards do not allow the user to go into debt

How a Debit Card Works

Debit cards serve a dual purpose: They allow the user to withdraw money from
his or her checking account through an ATM or through the cash-back function
many merchants offer at the point of sale. In addition, they also allow the user to
make purchases.

ATM cards, by contrast, only allow the user to withdraw money from an ATM,
while credit cards only allow purchases unless the credit card holder has a PIN-
enabled cash advance feature (and the cash advance will incur interest, unlike
withdrawing cash from a checking account).

Debit card purchases can usually be made with or without a personal
identification number (PIN). If the card has a major payment processor’s logo, it
can be run as a credit card, and the cardholder won’t need to take the risk of
exposing their PIN number. The money will still come directly out of the
cardholder’s checking account, and there won’t be any finance charges when the
debit card is run as a credit card. Some debit cards also offer reward programs,
similar to credit card reward programs, such as 1% back on all purchases.
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What are cryptocurrencies?

Cryptocurrencies, also known as virtual currencies or digital currencies, are a form
of electronic money. They do not physically exist as coins or notes. A
cryptocurrency unit, such as a bitcoin or ether, is a digital token created from
code using an encrypted string of data blocks, known as a blockchain. There are
usually only a fixed number of digital currency tokens available.

Cryptocurrencies are not only used as payment systems but can also be used to

execute contracts and run programs. Anyone can create a digital currency, so at
any given time there can be hundreds, or even thousands, of cryptocurrencies in
circulation.
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Virtual currencies can be bought or sold on an exchange platform using
conventional money. Some popular digital currencies, like Bitcoin can be bought
or sold for cash through special ATMs.

Electronic Funds Transfer (EFT)

Electronic Funds Transfer (EFT) is a system of transferring money from one bank
account directly to another without any paper money changing hands. One of the
most widely-used EFT programs is direct deposit, through which payroll is
deposited straight into an employee's bank account. However, EFT refers to any
transfer of funds initiated through an electronic terminal, including credit card,
ATM and point-of-sale (POS) transactions. It is used for both credit transfers, such
as payroll payments, and for debit transfers, such as mortgage payments.

How EFT works

Transactions are processed by the bank through the Automated Clearing House
(ACH) network, the secure transfer system that connects all financial institutions.
For payments, funds are transferred electronically from one bank account to the
billing company's bank, usually less than a day after the scheduled payment date.

The ACH Network operates as a batch processing system. Financial institutions

accumulate ACH transactions throughout the day, which are handled via batch
processing later on

Types of EFTs
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The most common types of EFTs include:

« Direct deposit: Enables businesses to pay employees. During the employee on
boarding process, new employees typically specify the financial institution to
receive the direct deposit payments.

« Wire transfers: Used for non-regular payments, such as the down payment on
a house.

« Automated Teller Machines (ATMs): Allows cash withdrawals and deposits,
fund transfers and checking of account balances at multiple locations, such as
branch locations, retail stores, shopping malls and airports.

« Debit cards: Allows users to pay for transactions and have those funds
deducted from the account linked to the card.

« Pay-by-phone systems: Allows users to pay bills or transfer money over the
phone.

« Online banking: Available via personal computer, tablet or Smartphone. Using
online banking, users can access accounts to make payments, transfer funds
and check balances.

Advantages of EFT:

The main advantage of an electronic funds transfer is time. Since all the
transaction is done automatically and electronically, the bank doesn’t need to pay
a person to do it, a person to drive the loans to the other bank, the cost of the
transport, the cost of the maintenance of the transport, insurance and the gas of

the transport. EFT’s have revolutionized modern banking.

Other benefit is immediate payment, which brings an up to date cash flow. You

won’t hear either about lost checks causes by the inefficiency of normal mail
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(nowadays known as snail mail for its velocity compared to emails) and up to date

bookkeeping.

There are numerous ways of transferring money from one bank account to
account. With the increasing technology, online money transfer has become the
easiest way of transferring money from one bank to another without any
difficulty. Here are three major means of transferring money.

1. NEFT
2. RTGS
3.UPI

4. IMPS

National Electronic Fund Transfer (NEFT)

National Electronic Fund Transfer (NEFT) is a nation-wide payments system that
allows transfer of funds from one bank’s account to another. With an increased
focus on online banking, NEFT has become one of the most popular ways of
transferring funds. Since it can electronically transfer funds from any bank branch
to any individual, it has eliminated the need to visit a bank branch for transfer of
funds. Let us learn about the how NEFT operates in India and what benefits it
offers. Let us find out what is NEFT.

What is NEFT Process?

Stated simply, if an individual wishes to transfer a sum of money from his bank
account to another person’s bank account, he can do so through the process

of NEFT, instead of withdrawing money and then paying it in cash or by writing
out a cheque. The main benefit offered by NEFT is that it can transfer funds from
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any account of any branch to any other bank account located at any given place.
The only condition is that both the sender and receiver branches should be NEFT-
enabled

Benefits of using NEFT

In the process of NEFT, you just have to enter the details of the beneficiary for the
first time after which you can just select the beneficiary from the list, enter the
amount and send. Take a look at some of the benefits of NEFT transactions that
could make your daily transactions simpler:

« No physical presence of either party is required to conduct a transaction.
Also, no physical instrument needs to be transferred at any point of time,
between the conducting parties, to conclude the transaction.

« Novisit to the bank is required, as long as a person holds a valid bank
account.

o Shortcomings of a physical instrument are easily overcome. This means that
NEFT has completely omitted instances of physical damage of any
monetary instruments, its theft or forging.

o NEFT is simple and efficient. It can be done in under a minute’s time and
hardly involves any major formality.

« Confirmation of a successful transaction can be easily received and viewed
through email and SMS notifications.

« Internet banking can be initiated and conducted from any place. This means
that a person does not need to be present at a particular location to make
NEFT transactions.

» Real time transactions provide assurance to both the parties.

Real-Time Gross Settlement (RTGS)

Real-time gross settlement (RTGS) is the continuous process of settling payments
on an individual order basis without netting debits with credits across the books
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of a central bank (e.g., bundling transactions). Once completed, real-time gross
settlement payments are final and irrevocable.

Real Time Gross Settlement (RTGS) is an electronic form of funds transfer where
the transmission takes place on a real time basis.

In India, transfer of funds with RTGS is done for high value transactions, the
minimum amount being Rs 2 lakh. The beneficiary account receives the funds
transferred, on a real time basis. The main difference between RTGS and National
Electronic Funds Transfer (NEFT) is that while transfer via NEFT takes place in
batches (with settlements and transactions being netted off), in the case of RTGS,
the transactions are executed individually and on gross basis.

The customer initiating the funds transfer through RTGS has to have the Indian
Financial System Code (IFSC) of the beneficiary's bank, along with the name of the
beneficiary, account number and name of the bank. The bank branches, both at
the initiating and receiving end, have to be RTGS-enabled for the transaction to
be processed. Customers with Internet banking accounts can do RTGS
transactions on their own

UPI (Unified Payments Interface):

A Unified Payments Interface is a real-time payment system that allows
transactions to be done through any smartphone using VPA (Virtual Payment
Address).

108 |Page




BCA-11IT www.sbs.ac.in

No bank account detail is needed for the money transfer through UPI. Only
mobile number or name is sufficient and the transactions can be done 24/7. UPI-
enabled apps allow the transfers up to Rs 1 lakh.

UPI or Unified Payments Interface is an immediate real-time payment system that
helps in instantly transferring the funds between the two bank accounts through

a mobile platform.Hence, UPI is a concept that allows multiple bank accounts to
get into a single mobile application. This idea was developed by the National
Payments Corporation of India and is controlled by the RBI and IBA(Indian Banking
Association)

Key Features of UPI

Some of the features of UPI are listed below:

* Instant transfer of fund through Immediate Payment Service (IMPS) which is
faster than NEFT.

* Since it is completely digital, one can use UPI 24 hours and on all public holidays.
* Single mobile application for accessing various bank accounts.

* Uses Virtual Payment Address which is a unique ID as given by the bank

* Uses Account Number with IFS Code and Mobile Number with MMID or Mobile
Money Identifier

* Bill Sharing facility.

* Best for doing merchant payment, utility bill payments, in-app payments, OTC
payments, Barcode based payments.

* One can file a complaint from Mobile App directly.
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IMPS (Immediate Payment Service)

Immediate Payment Service or IMPs an instant fund transfer service and it can be
used anytime. IMPS can be simply defined as NEFT+RTGS.

In order to avoid fraud complaints, the cap on transaction limit is set very low. For
IMPS transfer, you just need to know the destination account holder's IMPS id
(MMID) and his/her mobile number.

Steps to make IMPS money transfer:

Step 1:Using your Customer ID and Password into Net Banking/Mobile Banking
Step 2: Go to Funds Transfer tab (Other Bank Account)

Step 3: Select Debit / Credit Account, mode of transfer as IMPS and beneficiary
account

Step 4: Enter the amount to be transferred and click on Submit

Step 5: Click on the confirm button

Step 6: Recheck all the information and approve the transaction using OTP (one
time password) received on your registered mobile number

Step 7: And at last, confirm by clicking on the submit button.

Through IMPS, you can transfer money 24/7, But RTGS & NEFT can be done only
in working hours on weekdays + a few hours on Saturdays only. Other than NEFT,
RTGS and IMPS, you can also transfer your money through UPIl and cheque.

The major feature of IMPS is that it is available at all times for usage. It transfers
funds instantly and is a great banking platform in case of emergencies. The
transaction charges of this platform are also very nominal and the transfer limit
is also considerable, approximately Rupees 2 lakhs per day. Moreover, IMPS is
available on mobile too which makes it super-convenient.

DIGITAL SIGNATURE
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Digital signatures are like electronic “fingerprints.” In the form of a coded
message, the digital signature securely associates a signer with a document in a
recorded transaction. Digital signatures use a standard, accepted format,

called Public Key Infrastructure (PKl), to provide the highest levels of security and
universal acceptance. They are a specific signature technology implementation of
electronic signature (eSignature).

Digital signatures, like handwritten signatures, are unique to each signer. Digital
signature solution providers, such as DocuSign, follow a specific protocol,

called PKI. PKI requires the provider to use a mathematical algorithm to generate
two long numbers, called keys. One key is public, and one key is private.

When a signer electronically signs a document, the signature is created using the
signer’s private key, which is always securely kept by the signer. The
mathematical algorithm acts like a cipher, creating data matching the signed
document, called a hash, and encrypting that data. The resulting encrypted data is
the digital signature. The signature is also marked with the time that the
document was signed. If the document changes after signing, the digital signature
is invalidated.

As an example, Jane signs an agreement to sell a timeshare using her private key.
The buyer receives the document. The buyer who receives the document also
receives a copy of Jane’s public key. If the public key can’t decrypt the signature
(via the cipher from which the keys were created), it means the signature isn’t
Jane’s, or has been changed since it was signed. The signature is then considered
invalid.

CERTIFICATE AUTHORITY (CA)

A certificate authority (CA) is a trusted entity that manages and issues security
certificates and public keys that are used for secure communication in a public
network. The CA is part of the public key infrastructure (PKI) along with the
registration authority (RA) who verifies the information provided by a requester
of a digital certificate. If the information is verified as correct, the certificate
authority can then issue a certificate.
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Certificate authorities are trusted third-party entities who provide digital
certificates to organizations that have the need to ensure that their users are
provided with secure authentication and connection. Certificates given by CAs
build trust between the users and the providers because they can ensure the
validity of each other’s identities and authorities.

CAs provide the most basic security and business process principles in a public key
infrastructure by creating trust relationships between enterprise and entities

Introduction to Bluetooth

Bluetooth is a short-range wireless communication technology that allows devices
such as mobile phones, computers, and peripherals to transmit data or voice
wirelessly over a short distance. The purpose of Bluetooth is to replace the cables
that normally connect devices, while still keeping the communications between
them secure.

Bluetooth Technology

Developed in 1994, Bluetooth was intended as a wireless replacement for cables.
It uses the same 2.4GHz frequency as some other wireless technologies in the
home or office, such as cordless phones and WiFi routers. It creates a 10-meter
(33-foot) radius wireless network, called apersonal area network (PAN)or
piconet, which can network between two and eight devices. This short-range
network allows you to send a page to your printer in another room, for example,
without having to run an unsightly cable.
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How does Bluetooth work?

Bluetooth technology requires that a low-cost transceiver chip be included in
each device. The transceiver transmits and receives in a previously unused
frequency band of 2.45 GHz that is available globally -- with some variation of
bandwidth in different countries. In addition to data, up to three voice channels
are available. Each device has a unique 48-bit address from the IEEE 802 standard.
Bluetooth connections can be point to point or multipoint.

The maximum Bluetooth range is 10 meters. Data can be exchanged at a rate of
1 megabit per second -- up to 2 Mbps

Bluetooth is used for the following:

o Wireless control and communication between mobile and hands-free
headsets

o Wireless networking between multiple computers in areas with limited
service

« Wireless communication with PCs and peripheral input/output (1/0) devices

o Toreplace conventional wired communication, like GPS receivers, medical
equipment, traffic control devices and bar code scanners

o For low-bandwidth applications, when a higher USB bandwidth is not
desired

o Bridge multiple industrial Ethernet networks

« Wireless controllers in many interactive games and play stations

o Access dialup Internet connection via a PDA or PC

« Manage short-range data transmission between medical and cellular/other
tele-health devices

« Mobile phone communication with digital enhanced cordless
telecommunication (DECT)

« Identify and track object positions with the real-time location system

o Personal mobile security applications
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What Is Cloud Computing?

Cloud computing is the delivery of different services through the Internet. These
resources include tools and applications like data storage, servers, databases,
networking, and software.

Rather than keeping files on a proprietary hard drive or local storage

device, cloud-based storage makes it possible to save them to a remote database.
As long as an electronic device has access to the web, it has access to the data
and the software programs to run it.

Cloud computing is a popular option for people and businesses for a number of
reasons including cost savings, increased productivity, speed and efficiency,
performance, and security.
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Cloud computing

Understanding Cloud Computing

Cloud computing is named as such because the information being accessed is
found remotely in the cloud or a virtual space. Companies that provide cloud
services enable users to store files and applications on remote servers and then
access all the data via the Internet. This means the user is not required to be in a
specific place to gain access to it, allowing the user to work remotely.

Cloud computing is a general term for anything that involves delivering hosted
services over the Internet. These services are broadly divided into three
categories: Infrastructure-as-a-Service (laaS), Platform-as-a-Service (PaaS) and
Software-as-a-Service (SaaS). The name cloud computing was inspired by the
cloud symbol that's often used to represent the Internet in flowcharts and
diagrams
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Types of Cloud Services

Regardless of the kind of service, cloud computing services provide users with a
series of functions including:

o Email

« Storage, backup, and data retrieval
o Creating and testing apps

o Analyzing data

o Audio and video streaming

o Delivering software on demand

Big Data
Data

The quantities, characters, or symbols on which operations are performed by a
computer, which may be stored and transmitted in the form of electrical signals
and recorded on magnetic, optical, or mechanical recording media.

What is Big Data?

Big Data is also data but with a huge size. Big Data is a term used to describe a
collection of data that is huge in size and yet growing exponentially with time. In
short such data is so large and complex that none of the traditional data
management tools are able to store it or process it efficiently.

Characteristics Of Big Data

(i) Volume — The name Big Data itself is related to a size which is enormous. Size
of data plays a very crucial role in determining value out of data. Also, whether a
particular data can actually be considered as a Big Data or not, is dependent upon
the volume of data. Hence, 'Volume' is one characteristic which needs to be
considered while dealing with Big Data.
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(ii) Variety — The next aspect of Big Data is its variety.

Variety refers to heterogeneous sources and the nature of data, both structured
and unstructured. During earlier days, spreadsheets and databases were the only
sources of data considered by most of the applications. Nowadays, data in the
form of emails, photos, videos, monitoring devices, PDFs, audio, etc. are also
being considered in the analysis applications. This variety of unstructured data
poses certain issues for storage, mining and analyzing data.

(iii) Velocity — The term 'velocity' refers to the speed of generation of data. How
fast the data is generated and processed to meet the demands, determines real
potential in the data.

Big Data Velocity deals with the speed at which data flows in from sources like
business processes, application logs, networks, and social media sites,
sensors, Mobile devices, etc. The flow of data is massive and continuous.

(iv) Variability — This refers to the inconsistency which can be shown by the data
at times, thus hampering the process of being able to handle and manage the
data effectively.

Benefits of Big Data Processing
Ability to process Big Data brings in multiple benefits, such as-
o Businesses can utilize outside intelligence while taking decisions

Access to social data from search engines and sites like face book, twitter are
enabling organizations to fine tune their business strategies.

o Improved customer service
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Traditional customer feedback systems are getting replaced by new systems
designed with Big Data technologies. In these new systems, Big Data and natural

language processing technologies are being used to read and evaluate consumer
responses.

o Early identification of risk to the product/services, if any
o Better operational efficiency

DATA MINING

Data mining is the process of analyzing hidden patterns of data according to
different perspectives for categorization into useful information, which is
collected and assembled in common areas, such as data warehouses, for efficient
analysis, data mining algorithms, facilitating business decision making and other
information requirements to ultimately cut costs and increase revenue.

Data mining is also known as data discovery and knowledge discovery.
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The major steps involved in a data mining process are:

« Extract, transform and load data into a data warehouse

» Store and manage data in a multidimensional databases

» Provide data access to business analysts using application software

o Present analyzed data in easily understandable forms, such as graphs

The first step in data mining is gathering relevant data critical for business.
Company data is either transactional, non-operational or metadata. Transactional
data deals with day-to-day operations like sales, inventory and cost etc. Non-
operational data is normally forecast, while metadata is concerned with logical
database design. Patterns and relationships among data elements render relevant
information, which may increase organizational revenue. Organizations with a
strong consumer focus deal with data mining techniques providing clear pictures
of products sold, price, competition and customer demographics.

Data Mining as a whole process

The whole process of Data Mining comprises of three main phases:

1. Data Pre-processing — Data cleaning, integration, selection and transformation
takes place

2. Data Extraction — Occurrence of exact data mining

3. Data Evaluation and Presentation — Analyzing and presenting results
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In future articles, we will cover the details of each of these phase.

Applications of Data Mining

1. Financial Analysis
2. Biological Analysis
3. Scientific Analysis
4. Intrusion Detection
5. Fraud Detection

6. Research Analysis

Real life example of Data Mining — Market Basket Analysis

Market Basket Analysis is a technique which gives the careful study of purchases
done by a customer in a super market. The concept is basically applied to identify
the items that are bought together by a customer. Say, if a person buys bread,
what are the chances that he/she will also purchase butter. This analysis helps in
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promoting offers and deals by the companies. The same is done with the help of
data mining.

Mobile Computing

Mobile Computing is a technology that allows transmission of data, voice and
video via a computer or any other wireless enabled device without having to be
connected to a fixed physical link. The main concept involves -

e« Mobile communication
« Mobile hardware

« Mobile software
Mobile communication

The mobile communication in this case, refers to the infrastructure put in place
to ensure that seamless and reliable communication goes on. These would
include devices such as protocols, services, bandwidth, and portals necessary to
facilitate and support the stated services. The data format is also defined at this

stage. This ensures that there is no collision with other existing systems which
offer the same service.
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Since the media is unguided/unbounded, the overlaying infrastructure is
basically radio wave-oriented. That is, the signals are carried over the air to

intended devices that are capable of receiving and sending similar kinds of
signals.

Mobile Hardware

Mobile hardware includes mobile devices or device components that receive or

access the service of mobility. They would range from portable laptops,
smartphones, tablet Pc's, Personal Digital Assistants.
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These devices will have a receptor medium that is capable of sensing and
receiving signals. These devices are configured to operate in full- duplex,
whereby they are capable of sending and receiving signals at the same time.
They don't have to wait until one device has finished communicating for the
other device to initiate communications.

Above mentioned devices use an existing and established network to operate on.
In most cases, it would be a wireless network.

Mobile software

Mobile software is the actual program that runs on the mobile hardware. It deals
with the characteristics and requirements of mobile applications. This is the
engine of the mobile device. In other terms, it is the operating system of the
appliance. It's the essential component that operates the mobile device.
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Since portability is the main factor, this type of computing ensures that users are
not tied or pinned to a single physical location, but are able to operate from
anywhere. It incorporates all aspects of wireless communications.
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The Benefits of Mobile Computing

« Connectivity: You can stay connected to all sources at all times.
« Social Engagement: You can interact with a variety of users via the

Internet.
« Personalization: You can tailor your mobile computing to your individual
needs.
System

A system is an arrangement in which all its unit assemble work together
according to a set of rules. It can also be defined as a way of working, organizing
or doing one or many tasks according to a fixed plan. For example, a watch is a
time displaying system. Its components follow a set of rules to show time. If one
of its parts fails, the watch will stop working. So we can say, in a system, all its
subcomponents depend on each other.

Embedded System

As its name suggests, Embedded means something that is attached to another
thing. An embedded system can be thought of as a computer hardware system
having software embedded in it. An embedded system can be an independent
system or it can be a part of a large system. An embedded system is a
microcontroller or microprocessor based system which is designed to perform a
specific task. For example, a fire alarm is an embedded system; it will sense only
smoke.
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An embedded system has three components -

« It has hardware.
« It has application software.

« It has Real Time Operating system (RTOS) that supervises the application
software and provide mechanism to let the processor run a process as per
scheduling by following a plan to control the latencies. RTOS defines the
way the system works. It sets the rules during the execution of application
program. A small scale embedded system may not have RTOS.

So we can define an embedded system as a Microcontroller based, software
driven, reliable, real-time control system.
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Characteristics of an Embedded System

« Single-functioned - An embedded system usually performs a specialized

operation and does the same repeatedly. For example: A pager always
functions as a pager.

Tightly constrained — All computing systems have constraints on design
metrics, but those on an embedded system can be especially tight. Design
metrics is @ measure of an implementation's features such as its cost, size,
power, and performance. It must be of a size to fit on a single chip, must
perform fast enough to process data in real time and consume minimum
power to extend battery life.

Reactive and Real time - Many embedded systems must continually react
to changes in the system's environment and must compute certain results
in real time without any delay. Consider an example of a car cruise
controller; it continually monitors and reacts to speed and brake sensors.
It must compute acceleration or de-accelerations repeatedly within a
limited time; a delayed computation can result in failure to control of the
car.

Microprocessors based - It must be microprocessor or microcontroller
based.

Memory - It must have a memory, as its software usually embeds in ROM.
It does not need any secondary memories in the computer.

Connected - It must have connected peripherals to connect input and
output devices.

HW-SW systems — Software is used for more features and flexibility.
Hardware is used for performance and security.

Advantages

Easily Customizable
Low power consumption

Low cost
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« Enhanced performance
Disadvantages

« High development effort

o Larger time to market

Basic Sltructure of an Embedded System

The following illustration shows the basic structure of an embedded system -

. A-D Processor&
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A

Y

Memory

Y

o Sensor - It measures the physical quantity and converts it to an electrical
signal which can be read by an observer or by any electronic instrument
like an A2D converter. A sensor stores the measured quantity to the
memory.

« A-D Converter - An analog-to-digital converter converts the analog signal
sent by the sensor into a digital signal.

o Processor & ASICs — Processors process the data to measure the output
and store it to the memory.

« D-A Converter - A digital-to-analog converter converts the digital data fed
by the processor to analog data

o Actuator - An actuator compares the output given by the D-A Converter to
the actual (expected) output stored in it and stores the approved output.
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Internet Of Things(1OT)

The internet of things, or loT, is a system of interrelated computing devices,
mechanical and digital machines, objects, animals or people that are provided
with unique identifiers (UIDs) and the ability to transfer data over a network
without requiring human-to-human or human-to-computer interaction.

A thing in the internet of things can be a person with a heart monitor implant, a
farm animal with a biochip transponder, an automobile that has built-
in sensors to alert the driver when tire pressure is low or any other natural or
man-made object that can be assigned an IP address and is able to transfer data
over a network.

loT evolved from machine-to-machine (M2M) communication, i.e., machines
connecting to each other via a network without human interaction. M2M refers
to connecting a device to the cloud, managing it and collecting data.

How does it work?

Devices and objects with built in sensors are connected to an Internet of Things
platform, which integrates data from the different devices and applies analytics to
share the most valuable information with applications built to address specific
needs. These powerful loT platforms can pinpoint exactly what information is
useful and what can safely be ignored. This information can be used to detect
patterns, make recommendations, and detect possible problems before they
occur.
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The information picked up by connected devices enables me to make smart
decisions about which components to stock up on, based on real-time
information, which helps me save time and money.

Scenario #1: loT in your home

Imagine you wake up at 7am every day to go to work. Your alarm clock does the
job of waking you just fine. That is, until something goes wrong. Your train’s
cancelled and you have to drive to work instead. The only problem is that it takes
longer to drive, and you would have needed to get up at 6.45am to avoid being
late. Oh, and it’s pouring with rain, so you’ll need to drive slower than usual. A
connected or loT-enabled alarm clock would reset itself based on all these factors,
to ensure you got to work on time. It could recognize that your usual train is
cancelled, calculate the driving distance and travel time for your alternative route
to work, check the weather and factor in slower travelling speed because of heavy
rain, and calculate when it needs to wake you up so you’re not late. If it’s super-
smart, if might even sync with your loT-enabled coffee maker, to ensure your
morning caffeine’s ready to go when you get up.

o Cache Memory is a special very high-speed memory. It is used to speed up
and synchronizing with high-speed CPU. Cache memory is costlier than main
memory or disk memory but economical than CPU registers. Cache memory
is an extremely fast memory type that acts as a buffer between RAM and the
CPU. It holds frequently requested data and instructions so that they are
immediately available to the CPU when needed.

o Cache memory is used to reduce the average time to access data from the
Main memory. The cache is a smaller and faster memory which stores copies
of the data from frequently used main memory locations. There are various
different independent caches in a CPU, which store instructions and data.

« Level 1 or Register —
It is a type of memory in which data is stored and accepted that are
immediately stored in CPU. Most commonly used register is accumulator,
Program counter, address register etc.
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« Level 2 or Cache memory -
It is the fastest memory which has faster access time where data is
temporarily stored for faster access.

« Level 3 or Main Memory -
It is memory on which computer works currently. It is small in size and once
power is off data no longer stays in this memory.

« Level 4 or Secondary Memory -
It is external memory which is not as fast as main memory but data stays
permanently in this memory.
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